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Quick Start

Here are guidelines for quickly getting up and running with the 405™
TS Microplate Washer:

Install the 405 TS
Follow instructions for removing shipping
hardware and installing the instrument.

page 9

Optimize performance
Review the best practices for optimal
performance.

page 37

Review the Safety Information page 85

Copy the 405 TS Operator's Manual to
your computer to make it easy to find
reference information in the future. The
complete operator's manual is delivered
on the USB flash drive shipped with the
instrument.

Visit us at www.biotek.com.
1171009
Rev C
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Notices

BioTek Instruments, Inc.

Highland Park, P.O. Box 998

Winooski, Vermont  05404-0998  USA

All Rights Reserved

© 2013, BioTek® Instruments, Incorporated.  No part of this publication may be
reproduced, transcribed, or transmitted in any form, or by any means electronic
or mechanical, including photocopying and recording, for any purpose other
than the purchaser’s use without written permission of BioTek Instruments, Inc.

Trademarks

BioTek® is a registered trademark and 405™ TS Microplate Washer is a
trademark of BioTek Instruments, Inc.

Microsoft®, Internet Explorer®, Windows®, Windows 7, Windows 8, Windows
Vista®, Windows XP, and Excel® are either registered trademarks or trademarks
of Microsoft Corporation in the United States and/or other countries.

All other trademarks are the property of their respective holders.

Restrictions and Liabilities

Information in this document is subject to change and does not represent a
commitment by BioTek Instruments, Inc. Changes made to the information in
this document will be incorporated in new editions of the publication.  No
responsibility is assumed by BioTek for the use or reliability of software or
equipment that is not supplied by BioTek or its affiliated dealers.

405™ TS Microplate Washer
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Global Service and Support

BioTek instrument service and repair is available worldwide at several of BioTek’s
International Service Centers and in the field at your location. Contact the office
nearest you to arrange service or to get answers to your technical questions, call the
Technical Assistance Center (TAC) at 802-655-4740 in the US.

BioTek World Headquarters US BioTek China

Mailing Address:
PO Box 998, Highland Park
Winsooki, VT 05404-0998 United States

Service Shipping Address:
15 Tigan Street
Winooski, VT 05404 United States

Room 304, Tower D
Ocean International Center
62 Middle 4th East Ring Road
Chaoyang District
Beijing 100024
P.R. China

Phone: (800) 242-4685
Fax: (802) 654-0638

Phone: +86 (10) 85865569
Fax: +86 (10) 85861829

Email: TAC@biotek.com
Website: www.biotek.com

Email: infochina@biotek.com
Website: www.biotekchina.com.cn

BioTek Germany Service Center
& European Coordination Center

BioTek Instruments SAS
Bureau de liaison France

Kocherwaldstrasse 34 D-74177
Bad Friedrichshall
Germany

50 avenue d’Alsace
68025 Colmar Cedex
France

Phone: +49 (0) 71369680
Fax: +49 (0) 7136968111

Phone: +33 (3) 89206329
Fax: +33 (3) 89204379

Email: info@biotek.de
Website: www.biotek.de

Email: info@biotek.fr
Website: www.biotek.fr

BioTek India BioTek Singapore

Unit 223, Linkway Estate
New Link Road, MaladWest
Mumbai 400064
India

20 Science Park Road#01-08A
Teletech Park
Singapore 117674

Phone: +91 (22) 28789966
Fax: +91 (22) 28759944

Phone: +65 65922100
Fax: +65 67772611

Email: biotek@biotek.in
Website: www.biotek.in

Email: singapore@biotek.in
Website: www.biotek.com

BioTek Instruments, Inc.
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BioTek South Korea BioTek Switzerland

3F, Gyungnam building, 830-48
Yeoksam-dong, Gangnam-gu
Seoul, South Korea (135-936)

Zentrum FanhÖfli 8
6014 Luzern
Switzerland

Phone: +82 (0) 2-562-4740
Fax: +82 (0) 2-562-4750

Phone: +41 (41) 2504060
Fax: +41 (41) 2505064

Email: korea@biotek.com
Website: www.biotekinstruments.co.kr

Email: info@biotek.ch
Website: www.biotek.ch

BioTek United Kingdom (UK)

6 Bull Street
Potton, Bedfordshire SG19 2NR
United Kingdom

Phone: +44 (1767) 262000
Fax: +44 (1767) 262330

Email: info@biotek.uk.com
Website: www.biotek.uk.com

405™ TS Microplate Washer
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BioTek's Customer Resource Center

BioTek's Customer Resource Center (CRC) continues our tradition of superior service
and support. After an easy registration process, you can access lots of useful
information about your BioTek microplate instrumentation and software. On the
secure CRC website, you can:

l Track orders

l Access warranty information, user manuals and software updates

l Download technical and application information

l Maintain equipment inventory (product registration)

l Request service and technical support

l View service history

l And much more!

Register at https://customer.biotek.com

Intended Use Statement

l The 405™ TS Microplate Washer provides microplate priming, washing, and
dispensing for ELISA™, fluorescence and chemiluminescence immunoassays,
cellular and agglutination assays.

l If the instrument has an "IVD" label it may be used for clinical and non-clinical
purposes, including research and development. If there is no such label the
instrument may only be used for research and development and non-clinical
purposes.

Warnings

Operate the instrument on a level, stable surface away from excessive
humidity.
When operated in a safe environment, according to the instructions in this
document, there are no known hazards associated with the 405 TS.
However, the operator should be aware of certain situations that could
result in serious injury; these vary depending on the instrument type. See
Hazards and Precautions.

Strict adherence to instrument maintenance and qualification procedures
is required to ensure accurate dispense volumes and risk-free operation.

BioTek Instruments, Inc.

https://customer.biotek.com/
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Quality Control

It is considered good laboratory practice to run laboratory samples according to
instructions and specific recommendations included in the assay package insert for
the test to be conducted. Failure to conduct Quality Control checks could result in
erroneous test data.

Warranty and Product Registration

Please take a moment to review the Warranty information that shipped with your
product. Please also register your product with BioTek to ensure that you receive
important information and updates about the product(s) you have purchased.

You can register online through BioTek’s Customer Resource Center (CRC) at
www.biotek.com or by calling 888/451-5171 or 802/655-4740.

Repackaging and Shipping

If you need to ship the instrument to BioTek for service or repair, contact BioTek
for a Return Materials Authorization (RMA) number and use the original packing
materials. Other forms of commercially available packaging are not recommended
and can void the warranty. If the original packing materials have been damaged or
lost, contact BioTek for replacement packing.

405™ TS Microplate Washer
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Install the 405 TS

Follow the instructions in this section to install your
instrument.

Unpack and Inspect the Instrument 10
Remove the Shipping Hardware 10
Setting Up the 405 TS 14
Install Software/Connect to Computer 20
Connect to Power 21
Define Instrument Settings 22
Verify Performance 25
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Unpack and Inspect the Instrument

Important: Save all packaging materials. If you need to ship the instrument or
accessories to BioTek for repair or replacement, you must use the original packaging.
Using other forms of commercially available packaging is not recommended and can void
the warranty. Improper packaging that results in damage to the instrument may lead to
additional charges. Refer to the operator's manual for repacking instructions.

Inspect the shipping box, packaging, instrument, and accessories for signs of
damage.

If the 405™ TS Microplate Washer is damaged, notify the carrier and your BioTek
representative. Keep the shipping cartons and packing material for the carrier’s
inspection. BioTek will arrange for repair or replacement of your instrument
immediately, before the shipping-related claim is settled.

1. Unpack the boxes containing the instrument and other equipment:

l 405™ TS Microplate Washer and accessories

l Vacuum Pump and accessories

l Vacuum Filtration Accessory Kit

2. Place all packing materials back into the shipping boxes for reuse if necessary.

Refer to the Package Contents on page 107 to make sure you have all expected
equipment.

Remove the Shipping Hardware

The 405 TS is shipped with a protective manifold shipping bracket. Remove this
bracket before using the washer and reinstall it prior to shipping to avoid
irreparable damage to the manifold. Failure to remove and reinstall the shipping
bracket may void your warranty.

Keep in mind that you must reinstall the shipping hardware and use the original
shipping material if it is necessary to return the instrument to BioTek for service or
repair.

405™ TS Microplate Washer
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Remove the manifold shipping bracket

1. Use the 9/64” (3.57 mm) hex wrench to
unscrew the cap screws at the base of
the shipping bracket and remove it.

2. Slide the bracket towards you and
remove.

l Most brackets are black, unlike
the one shown here.

3. Store the bracket: mount it on the back
panel, on the studs provided.

l Direct Drain Waste System: if you are
using the direct drain waste method,
wait till later to mount the shipping
bracket. For direct drain, an
intermediate collection bottle is
attached to the washer using the
same studs as the shipping bracket.
See the Direct Drain Kit instructions.

405 TS with Verify™ Technology "Q" Models
"Q" Models have
three shipping
brackets:
remove two
before powering
up, and the last
one after start
up.

BioTek Instruments, Inc.
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1. Use the 9/64” hex wrench to unscrew the
cap screws and remove the bracket on the
side of the wash manifold that holds the
Verify sensor in place.

2. Remove the large bracket in front holding
the wash manifold: Remove the three
screws. Slightly lift the manifold(s) to
release the bracket from the base, and pull
it away from the manifold(s).

3. Set the brackets, screws and washers aside.

Follow instructions to set up the washer, e.g.
install the vacuum pump and tubing. Then,
perform Step 4, below.

4. When you're ready to power up the
instrument, plug it in and turn it on.
Release the latch on the left side of the
Verify™ sensor unit, and to lift it up to
remove the third shipping bracket.

5. For safe keeping, put the cap screws and
washers for the two thin brackets in the
studs provided on the longest, last-
removed bracket.

6. Put the manifold bracket's top screw back
in its hole. Save the two longer screws for
storing all the brackets on the back of the
instrument.

405™ TS Microplate Washer
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Layer the brackets on top of each
other on the studs on the back.

7. Store the brackets: mount them on the back
panel on the studs provided. Beginning
with the longest (3rd) bracket, layer the
brackets on top of each other, and use the
longest screws to secure them in place.

BioTek Instruments, Inc.
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Setting Up the 405 TS

Important: Avoid excessive humidity. Condensation directly on the sensitive
electronic circuits can cause the instrument to fail internal self checks.

Install the instrument on a level, stable surface in an area where ambient
temperatures between 10°C (50°F) and 40°C (104°F) can be maintained.

The instrument should be operated in a non-condensing humid environment
having a maximum relative humidity of 80% at temperatures up to 31°C
decreasing linearly to 50% relative humidity at 40°C.

Connect the Vacuum Pump, Tubes, and Bottles

For optimal operation of the 405 TS, all tubing, cables, and fittings for the fluid
supply and waste systems must be properly connected. This image illustrates
the rear panel of the instrument and the locations of the ports and connections
for the fluid supply and waste systems.

Rear Panel

Follow the Direct Drain Waste System Instructionsprovided with if you
purchased this accessory (in lieu of the standard waste system described below).

405™ TS Microplate Washer
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Waste System

Caution! Pump Installation. Do not plug the vacuum pump cable into a wall
outlet! Use the adapter provided with the pump to connect it to the Accessory
Outlet on the back of the instrument. This allows the 405 TS to regulate the
pump, turning it on and off as specified by the protocol.

When using a standard pump (rather than the high flow pump), set the
instrument’s Vacuum Dissipation Delay to prevent the pump from drawing
excess current and blowing the 5-amp fuse. See Define Instrument Settings  on
page 22

l Note: The waste tubes have colored bands that match similarly colored
dots next to the inlet/outlet ports on the waste bottle caps to ensure the
correct connection of the tubing.

Waste System

BioTek Instruments, Inc.
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Three lengths of tubing are shipped with the waste module:

Tubing: Connects:
Short tube with yellow and green bands g The two waste bottles to each other

Long tube with green bands on both ends g Bottle without sensor to vacuumport

Long tube with yellow and orange bands g Bottle with waste sensor to the vacuum
pump

1. Locate the quick-release caps shipped inside the waste bottles and attach the
tubing to them as follows:

2. Connect the waste bottles to each other using the shortest length of tubing,
matching the colored bands on the tubing to colored dots on the caps.

3. Attach the waste sensor cable to the Waste Sensor port on the back of the
washer.

4. Attach the tube from the waste bottle with the waste sensor in its cap to the
vacuum pump.

5. Attach the tube from the waste bottle that does NOT have the waste sensor
in its cap to the Vacuum port on the back of the instrument.

6. Important! When installing BioTek’s vacuum pump, connect the pump’s AC
power cable to the vacuum pump Accessory Outlet on the back of the
instrument. (Use the accessory outlet adapter provided, if applicable.)

7. Place the waste bottles and vacuum pump on the same horizontal plane as the
instrument or below it, such as the floor beneath the work surface. This will
help optimize performance.

8. Make sure the waste bottle’s caps are well sealed.

l BioTek strongly recommends installing the vacuum line filter to protect
your vacuum pump.

Install the Vacuum Line Filter

The optional vacuum line filter (PN 48294) can be installed halfway between the
last waste bottle (overflow bottle) and the vacuum pump.

To do this, cut the tubing and insert the filter, noting the direction of flow. The flow
arrow on the filter should point toward the vacuum pump.

In the event of a fluid overflow, the filter should prevent the destruction of the
vacuum pump’s internal components. If an overflow does occur, check the filter for
trapped fluid. If fluid is found in the filter, remove the filter and drain using the
small white nut on top of the filter. Tighten the white nut and reinstall the filter.

405™ TS Microplate Washer
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Install the Fluid Supply System

Prepare the supply bottles and tubing:

1. Remove the Quick Release Connector
from its bag inside the supply bottle
and connect it to the raw supply
tubing provided.

l You may need to cut the tubing to the
desired length.

2. Snap the connector into the top of the
supply bottle.

BioTek Instruments, Inc.
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Make sure you hear the
connector click!

Attach the labels provided
with the washer to identify
the buffer bottles.

Note: To avoid spilling fluid when refilling bottles or changing reagents, first release the
Quick Connector from the bottle cap, use a paper towel to sop up the few drops in the
cap. Then, refill the bottle.

With Buffer Switching (4 Buffers):

1. Place the four supply
bottles on the same
surface as the
instrument.

2. Connect the tubing from
one of the supply bottles
to the “A” port on the
back of the washer.

3. Repeat step 2 with the
other three supply
bottles for “B,” “C,” and
“D” Buffers.

405™ TS Microplate Washer
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Without Buffer Switching (1 Buffer)

1. Place the supply bottle(s) on the same
horizontal plane as the instrument.

2. Connect one the tubes to the Dispense
Fluid In port.

Install the Microplate Carrier

l Make sure the serial number on the underside of the plate carrier matches
the washer's serial number. If the numbers do not match, call BioTek
TAC immediately.

1. Line up the tab on the underside of the carrier with the slot on the carrier
transport block.

2. Put the two carrier rail guides onto the transport rail. The tab should sit in the
slot.

Final Check

l Verify that the tubing was not crimped during installation.

BioTek Instruments, Inc.
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l Ensure that there are no loose fittings or cable connections.

Attach the Mist Shield

1. Position the mist shield so the
gaps align with the
thumbscrews. The top rests on
the two rubber pads above the
manifold.

Always lift the mist shield
straight up, not towards you,
when removing it.

405 TSs equipped with Verify™ Clog
Detection Technology ("Q" models)
have a smaller mist shield.

Install Software/Connect to Computer

If you purchased BioTek's Liquid Handling Control™ (LHC) Software to control the
405 TS using your personal computer (PC), please refer to the LHC Installation
Guide for complete installation and setup instructions.

405™ TS Microplate Washer
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Connect to Host Computer

Using the USB cable: Plug one end into the USB port labeled Computer on the
instrument and the other end into an available port on the computer.

l If the computer is connected to the Internet, turn on the instrument. Let
Windows® automatically locate and install the necessary USB drivers (follow
the online instructions), if applicable or open the link below to download the
drivers.

l Virtual Com Port (VCP) drivers for all Windows operating systems are available
at http://www.ftdichip.com/Drivers/VCP.htm

l If the computer is NOT connected to the Internet, install the drivers using the
supplied “Virtual USB Com Port” driver software CD.

l The Home screen must be displayed for the LHC to communicate with the
instrument.

Technical Note: Only one of the two communication ports (COM port) on the
instrument can be used at a time. They cannot be used simultaneously. You can

use USB to connect the 405 TS to the computer or the RS232 serial port to connect to
a BioStack or similar robotic device. But you cannot use both ports simultaneously,
i.e. make sure only one cable is plugged in at a time.

Connect to Power

Warning! Power Rating. The 405 TS must be connected to a power receptacle
that provides voltage and current within the specified rating for the system. Use
of an incompatible power receptacle may produce electrical shock and fire
hazards.

Warning! Electrical Grounding. Never use a two-prong plug adapter to
connect primary power to the 405 TS. Use of a two-prong adapter disconnects
the utility ground, creating a severe shock hazard. Always connect the system
power cord directly to a three-prong receptacle with a functional ground.

The 405 TS supports voltage in the range of 100-240 V~ at 50-60 Hz. 

1. Plug the power cable into the power cable socket in the rear panel of the 405 TS.

2. Insert the three-prong plug into an appropriate receptacle.

BioTek Instruments, Inc.
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Define Instrument Settings

LHC Users Only

When using the LHC to control the 405 TS, an important first step is
defining your instrument’s settings. After installing the LHC, you can use the
desktop icon or the Windows Start button to launch the LHC:

> All Programs> BioTek> Liquid Handling Control

1. Click the Name link on the main page and, if required, select the 405 TS.

2. Specify the COM Port used to connect the 405 TS to the computer (use the
drop-down list to select the port) and click Test Communication.

l Pass: proceed to the next step.

l Fail: check the Com Port setting. See “About Com Ports” in the LHC Help.

3. In the Target Instrument Settings dialog that opens, click Get actual settings
now, and click OK.

Standard Vacuum Pump Users

l Do not perform this step when using the High Flow vacuum pump (PN
7100754). High flow pumps are recommended when aspirating 384-well
plates with non-surfactant wash buffers (e.g., pure deionized or distilled
water).

Perform this step ONLY if you are using the “standard” vacuum pump (PN
7103024): increase the Vacuum Dissipate Delay to match your waste container:
1 second per liter.  For example, if you have a 10 L waste bottle, set the delay to
10 seconds.

405™ TS Microplate Washer
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Using the LHC Using the Touch screen

1. Select Tools>Instrument
Utilities.

2. Under General Settings, increase
the Vacuum Dissipate Delay to
match your waste container: 1
second per liter.

3. Click Send to download this new
setting to the instrument.

4. Click Exit to return to the main
screen.

1. Press Instrument>Options

2. Touch the Advanced Settings link.

3. Touch the number field to set the
Vacuum Dissipate setting to
match your waste container: 1
second per liter.

4. Press the previous button and
then Home button.

Setting the Time and Date

Set the time and date to permit the 405 Touch to record "last modified" and "last run"
data for each protocol. Only one time and date format is available: DD Month YY. An
internal battery keeps the time and date valid when the instrument is turned off.

1. Select Instrument from the Home screen, press Next and then, Other.

2. Select Set Time and Date.

3. Update the time zone, date, and time:

l Time Zone: Touch the Select Time Zone button and select the option that
matches your location. GMT = Greenwich Mean Time.

l Time: Touch the time field to open a number pad. Enter the current hour and
minutes to set the 24 hour clock.

l Date: Touch today's date on the calendar to select it. Press the previous or next
arrows next to the month to scroll to the correct month.

4. Press Save.

Remember to update the time in accordance with annual time shifts, like Daylight Savings
Time, if applicable.

Define Startup Preferences (LHC users only)

You can save enormous time creating protocols by following these steps to define a
New Protocol template and use it at startup.

BioTek Instruments, Inc.
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Create a protocol template

1. Click the New button or select File>New.

2. Click Name. Select the 405 TS and define its Port and Settings.

3. Highly Recommended: select the Plate Type, fill in the text fields, and add any
steps that you want all new protocols to include.

4. Click Save and assign a unique name, e.g. Template.LHC.

5. Select Tools>Preferences>New Protocol.

6. Select the button for Protocol selected below to use as a template.

7. Click selected and select the protocol you created as a template.

Define startup behavior:

8. After completing the steps above, select the Startup Options tab.

9. Select the button for New Protocol.

10. Click OK to save your new preferences.

405™ TS Microplate Washer
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Verify Performance

Before using the 405 TS for the first time, verify that it is operating properly.

l When using the LHC, make sure the 405 TS is connected to the PC and both are
powered up.

l When running standalone, turn on the 405 TS.

Using the touch screen:

Press Instrument and then Self-Check.

Using the LHC:

1. Click the Name link on the main page and, if required, select the 405 TS.

2. Define the COM Port used to connect the 405 TS to the computer and Test
Communication.

3. In the Target Instrument Settings dialog that opens, click Get actual settings now,
and click OK.

4. Select Tools>Instrument Utilities

5. On the General Settings tab, click the Perform Self-Check link.

Test results:

l Pass: no error message is displayed.

l Fail: an error message is displayed. If this happens, note the error code and refer
to Troubleshooting on page 94 to determine its cause. If the problem is
something you can fix, turn off the instrument, fix the problem, and then turn the
instrument back on. Otherwise, contact BioTek’s Technical Assistance Center.

The Qualification Chapter in the operator’s manual provides Installation and
Operational Qualification procedures to perform after the instrument is installed and
before the instrument is used in a laboratory environment. 

l Important! Before operating the instrument, review Optimize
Performance on page 37. The guidelines include necessary steps to
perform before running a protocol, and issues to consider when creating or
editing protocols.

BioTek Instruments, Inc.
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Verify the Washer

1. Fill the washer’s supply bottle (bottle “A” for buffer switching models) with
approximately one liter of deionized water.

LHC Touch screen

1. Select File > Open.

2. Open the 405 TS and the Prime and
Maintenance Protocols folders.
Open the applicable "Buffer" folder,
and then open W-DAY_RINSE.LHC

You may need to reset the Com
Port.

3. When ready, click the Run button
to prime the tubing and manifold
with deionized water.

4. When finished, close the program.

1. Select Maintenance at the Home
screen.

2. Select W-Day_Rinse and press
Start.

3. When the protocol is completed,
press the Home button.

Run the Verify Test ("Q" Models Only)

If your 405 TS is equipped with BioTek's Verify™ Technology, run the test:

Important! Before running the test:

Make sure the 405 TS is primed and ready to run:

l Fully prime the tubing/system, e.g. runW-Day Rinse.

l If necessary, empty waste vessel and tighten waste bottle cap.

Prepare to run the Verify test:

l Fill the supply vessel with at least 100 mL dH2O or DI water or buffer solution1.

Run the Verify test:

Touch screen

1. Select Quick>Verify Manifold and specify the parameters:

1Do not use highly viscous fluids or wash buffers that are prone to leave significant residue on the plate.

405™ TS Microplate Washer
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l Buffer: Select the bottle to use, if applicable.

l Prime: optionally, prime the manifold tubes to correct for evaporation loss. 40
mL of fluid is dispensed.

l %CV Threshold: optionally, change the %CV to match your lab's standard for
QC tests: 5-15%. The default value of 5% is recommended.

2. Press Start to run the test.

3. Assess the results: Verify Results.

Do not discard the Verify Test Plate. Reuse it for as long as possible.

405 Touch: BioTek recommends exporting the initial test results and saving them for
future reference.

Contact BioTek TAC if any of the tests fail.

BioTek Instruments, Inc.



28 | 405 TS Getting Started Guide

405™ TS Microplate Washer



Basic Operation

This section introduces the basics of operating the 405 TS. For
more detailed and comprehensive instructions, please refer to
the operator's manual on the CD shipped with this guide.
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Touch Screen Basics

Home screen

l Fast, Light Touch: a light, quick tap on the screen produces the best results.
Use your fingertip or a pointing device like a pen tip. The touch screen does not
support gestures, like swiping and zooming, that are common to smart phones.

Do Don't

Do use your fingertip
(precise selection)

Don't use your finger pad
(uncertain selection)

l Wash Protocols: Touch a protocol on the Home screen to run it. All
saved/predefined protocols appear on the Home screen.

Numbers: Touch any field that requires a numeric value to open a
field-sensitive number pad. Use the number pad to specify volume,
times, and other values. To enter negative numbers use the down
(decrement) arrow.

Pick Lists: touch a field with a down arrow to open a pick list to
select a value.

405™ TS Microplate Washer
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Text: Touch any text field or comments box to open a keyboard.
Use the keyboard to name protocols, input runtime prompts, enter
comments, etc.

Scrolling: Press the down or up arrows to scroll a list with more
items than fit on the screen.

Quick access to prime the washer, wash a plate, and when
equipped: AutoClean to sonicate the manifold and Verify™
Technology to check for clogged aspirate and dispense tubes.

To create and modify protocols.

To run maintenance and quality control protocols.

To change instrument settings, obtain protocols from a memory
stick, etc.

Home: Press the home button to return to the Home screen at any
time.

Previous: Press the previous button to go to the previous screen.

Help: To learn more about a screen, press its Help button.

Green buttons make the 405 TS perform.

Two ways to wash a plate

The 405 TS offers two ways to wash a plate:

l Quick Wash: using the touch screen you can wash a plate by defining a few
parameters like fluid volume and number of wash cycles and rely on default
parameters for the more advanced options. .

l Run a Wash Protocol: using either the touch screen or the LHC you can run a
wash protocol to wash a plate. You can run a predefined protocol or define your
own protocol to specify the optimal parameters for your assay. See Running
Predefined Protocols on page 39.
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Create or Modify a Protocol

SelectDefine at the Home screen
To create or edit a protocol:

1. Select Define at the Home/Maintenance screen.

2. Press Create or highlight the protocol and press Edit.

3. Name:
l New protocols: Touch the name field to open a keyboard.
Enter a unique name for the protocol.

l Editing protocols: Press the Info button and touch the
name field to change the protocol name. This will create a
new copy of the protocol you are editing. Later you can
delete the original file, if desired.

4. Plate Type:

l New protocols: If needed, touch the plate type field to
select a different plate type.

l Editing protocols: Press the Info button and touch the
Plate Type field to change the plate type.

5. Add/Edit steps:

l New protocols: Add a step to the protocol
(touch the Add button), select a step and
define its parameters.

l Editing protocols: Highlight a step and
press Edit to modify its parameters.

l Adding steps: Highlight the <end of
steps> or a step to be preceded by the
new step, and press Add and the action
button to insert a step.

Copy a similar protocol and then edit it to meet different requirements or to test
different parameters.

When editing a protocol, cut and paste steps to move them to the correct position.
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6. Continue adding or editing steps, as needed.

7. Press Save to save the protocol. All saved protocols are put on the
Home screen for easy retrieval.

Optionally, do a test run to verify the protocol performs
as expected. Test Run executes the protocol. Fill vessels
with water or disconnect them if you want to preserve
reagent.

Especially when creating complex BioStack protocols, use
the Validate button to check the order of the protocol
steps.

Add protocols to the Home screen

The 405 TS puts all saved protocols on the Home screen for easy retrieval. Create and
save a protocol to add it to the Home screen listing.

Remove protocols from the Home screen

All saved protocols appear on the Home screen. To remove a protocol from the
Home screen listing:

1. Select Define at the Home screen.

2. Highlight the protocol you want to remove and press Delete.

The protocol file will be permanently deleted.

l To delete a locked protocol, first unlock it.

Locked files: you can "unlock" a protocol by replacing it using the Protocol Transfer
control. Upload the protocol to a USB stick, make sure "Lock files" is disabled and re-transfer
the protocol. It will overwrite the existing file.

Change the Plate Type

Edit a protocol to change its plate type:

1. Select Define at the home screen.

2. Highlight the protocol and press Edit.

3. Press the Info button on the step definition screen and touch the Plate Type field
to change the plate type.
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4. Press OK to save the change. Press Save at the step definition screen to save the
protocol.

Empty the priming trough

Perform a Self-Check to empty the priming trough, if necessary: press Instrument
at the Home screen and press Self-Check on the Current Config screen.

Verify Performance

Quick>Verify Manifold

BioTek's Verify™ Technology quickly detects clogged aspirate or dispense tubes.

Important! Before running the test:

Make sure the 405 TS is primed and ready to run:

l Fully prime the tubing/system, e.g. runW-Day Rinse.

l If necessary, empty waste vessel and tighten waste bottle cap.

Prepare to run the Verify test:

l Fill the supply vessel with at least 100 mL dH2O or DI water or buffer solution1.

Run the Verify test:

Touch screen

1. Select Quick>Verify Manifold and specify the parameters:

l Buffer: Select the bottle to use, if applicable.

l Prime: optionally, prime the manifold tubes to correct for evaporation loss.
40 mL of fluid is dispensed.

l %CV Threshold: optionally, change the %CV to match your lab's standard
for QC tests: 5-15%. The default value of 5% is recommended.

2. Press Start to run the test.

3. Assess the results: Verify Results.

Do not discard the Verify Test Plate. Reuse it for as long as possible.

1Do not use highly viscous fluids or wash buffers that are prone to leave significant residue on the plate.
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Frequency:

5 Minutes: Gain complete confidence that your plates will be processed correctly by
spending five minutes to run the Verify test before running your assay!

Develop a schedule for running the Verify routine based on the type of wash buffer
you are using, how frequently you use the washer, and your maintenance habits:

l Daily: When using PBS, protein, and other fluids that easily crystallize and
harden, potentially clogging the tubes, run the Verify routine every day and/or
after prolonged downtimes to ensure the tubes are not clogged.

l Weekly: When using TRIS and other low-salt buffers and when adhering to the
recommended maintenance schedule, you can confidently run the Verify routine
less frequently, e.g. before new assay runs.

Replace the Verify Test Plate (according to the prescribed procedure) if it is
damaged, scratched, warped, etc.

For more details: See About Verify Technology in the operator's manual.

Handling the Verify Test Plate

The Verify Test Plate ships in its own special box. The plate is labeled with the serial
number of the 405 TS that has been calibrated for its use.

l Well A1 is opposite the
chamfered or beveled
edges.

l The plate is labeled with
the washer's serial
number.

l When the plate is on the
carrier in the proper
orientation, the "Front"
label is visible.

Verify Test Plate
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Important guidelines:

l Always put the plate on the carrier with well A1
in the back, left corner of the carrier.

l Clean the plate after each use if you are using
wash buffer to run the test.

l Fully dry the plate after each use and before
putting it back in its foam-lined box.

l Inspect the plate regularly for damage, e.g.
scratches, chips, warping.

l Replace the plate when it is damaged. See
Replacement Procedure for Verify Test Plate in
the operator's manual.

405™ TS Microplate Washer



Optimize Performance| 37

Optimize Performance

Here are some guidelines to ensure optimal performance and to prevent problems.

Keep the devices clean and the tubing wet

The most critical factor for ensuring optimal performance is to adhere to the
Recommended Maintenance Schedule on page 77. Enable AutoPrime to keep tubes
from clogging.

Prime the tubing to remove air bubbles
l See 405 Recommendations for Priming the Washer on the next page

Best Practices

l Fill the supply bottles with sufficient fluid. Never run the 405 TS without the fluid
filter installed (on the end of the tubing inside the supply bottle).

l Note: To avoid spilling fluid when refilling bottles or changing reagents, first release
the Quick Connector from the bottle cap, use a paper towel to sop up the few drops in
the cap. Then, refill the bottle.

l Make sure the bottles, solutions, and tubing are clean and do not contain any
particles or mold. Solutions that are recycled over several days will grow algae,
bacteria, molds, or other undesirable organisms.

l Prime before dispensing. Priming the tubing is the most critical factor in assuring
optimal performance.

l Empty the waste bottles and firmly seat the bottles’ caps and quick release
connectors. To make sure fluid does not back up into the vacuum pump during
operation keep the waste sensor cable installed and the waste detection sensor
activated. If fluid collects in the overflow bottle, thoroughly rinse the fluid-level
switch and bottle.

l Check the external tubing connections for kinks and clogs.

l When equipped with BioTek's Verify™ Technology ("Q" models), before
processing your assay plates, take five minutes to run the Verify routine to
ensure the manifold tubes are not clogged.

l Put microplates on the carrier with well A1 in the left rear corner as you face the
instrument, and firmly seat the plate in the carrier.
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405 Recommendations for Priming the Washer

These recommended prime volumes are required to achieve 95% or higher purity
when changing wash buffers.

Model Buffer Switching One Buffer

405 TS/LS 300 250

HT 300 250

Buffer Switching models have four buffer valves; otherwise, only one reagent bottle
may be connected to the washer. For Select models (with Cell Wash (CW)
capability), the recommended prime volume is the same with and without Buffer
Switching.

Model Quick Prime Prime step

Select 300 Main Low Flow

150 150

Manifold Prime: 50 mL is recommended to clear air from the manifold only and
to wet the tips. This is recommended before running a protocol to correct fluid loss
due to evaporation.

Dead Volume

BioTek's recommended prime volumes are based on purity testing and measured
dead volumes. Generally, priming with three times the dead volume assures
purity.

Model Dead Volume

405 TS/LS 108 mL

HT 108 mL

Select 129 mL

For models with buffer switching tubing, dead volume is ± 2 mL additionally.
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Running Predefined Protocols

BioTek provides numerous predefined protocols for maintaining the instrument in
top condition and for qualifying its performance. Review the Predefined
Protocols on page 41.

To run a defined protocol:

LHC Touch screen

1. Select Open and locate the 405 TS
folder.

2. Open the 405 TS folder. Find the desired
protocol for your instrument model.

Important: Be sure to Customize the
Predefined Protocols below

1. Touch a protocol on the
Home screen to select it.

2. Press Start to run it.

Creating Protocols: Washing, Aspirating and Dispensing Fluid

In addition to the quick routines available from the touch screen's Home screen, you
can define and run protocols. Protocols offer more parameters, giving you the ability
to fine-tune instrument performance, and perform more complex processing.

Touch Screen Control

See Create or Modify a Protocol on page 32

Liquid Handling Control™ (LHC) Software

Launch the LHC software to create or modify protocols, see on page 1on page 1.

LHC Users Only: Customize the Predefined Protocols

BioTek provides predefined protocols for maintenance routines and instrument
qualification tests. You can quickly customize the protocols for regular use.

The LHC keeps track of the last-used COM port for an instrument type. For example, when
an EL406 runs a protocol, the LHC logs the COM port used and the next time an EL406 is used,
the LHC applies the same COM port setting. You can disable this feature by defining your
Ports preference: select Tools>Preferences>Ports.
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To correct the COM port for the current protocol, click the Port link and use the drop-down
list to select the correct value. The LHC stores the COM port value in the protocol file.

With the 405 TS connected to and communicating with the host computer (i.e.
make sure the instrument is turned on and not busy):

1. Click the Open button, locate the 405 TS folder and click Open.

2. Open the Maintenance or other folder and select the desired protocol.

3. Change the COM port if necessary: click Port and enter the correct value
or select from the drop-down list.

4. Click Settings, which opens the Instrument Settings dialog.

5. Under Get settings from: click the instrument link.

6. Click Validate.

A "Validation successful" message is displayed unless the protocol cannot be
run on your instrument.

7. Save the protocol.
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Predefined Protocols Listing

LHC Users: Folders named 4Buffers and 1Buffer contain customized protocols for
models with and without Buffer Switching, respectively.

Maintenance Protocols

Daily
Maintenance Description

W-DAY_
RINSE

Simple one-step protocol to fully flush the system with water or
reagent to keep the manifold tubes clog-free. Defined for use with
Buffer A; 500 mL total volume.

W-
OVERNIGHT_
LOOP

Protocol designed to keep the manifold in a wetted condition
overnight or for a long downtime period; manifold tubes are
submerged in fluid for 4-hour intervals between primes in this virtually
endless loop. Defined to use Buffer A.

W-RINSE_
AND_SOAK

Identical to W-DAY_RINSE with one addition, the manifold tubes are
submerged and soaked for 5 minutes in the fluid.

Periodic Maintenance

W-
Decontaminate

Two/three stage protocol to decontaminate the washer, first
flushing lines with disinfectant and then rinsing them with
deionized or distilled water. Buffer switching models flush and
then rinse all four lines. Manifold tubes are submerged and
soaked for 20 minutes during each pass. Prompts guide the user
through the process.

W-LONG_
SHUTDOWN

Helps implement the recommended procedure for preparing the
instrument for storage. This protocol includes prompts for running
disinfectant from Buffer A, then water from Buffer B, and lastly,
air through the system - remove bottle from Buffer C valve.

W-PRIME_
250/300

Simple prime routine; defined for Buffer valve A only. For LHC
only.

PRIME_ALL_
BUFFRS

Consecutively primes each of the Buffer Switching valves
beginning with D. Designed for use in the annual instrument
verification test of the Buffer Switching module.
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QC (Quality Control) Protocols

Manifold-Specific

QC_96_DISP_TEST Dispense precision test protocol for 96-tube manifold.

QC_96_EVAC_
TEST

Evacuation efficiency test protocol for 96-tube manifold.

QC_192_DISP_
TEST

Dispense precision test protocol for 192-tube manifold.

QC_192_EVAC_
TEST

Evacuation efficiency test protocol for 192-tube manifold.

QC_96_VAC30_
TEST

Vacuum filtration evacuation efficiency test for 96-well filter
plates and also recommended for use in maintenance
procedures.

QC_384_VAC10_
TEST

Vacuum filtration evacuation efficiency test for 384-well
filter plates and also recommended for use in maintenance
procedures.

Predefined Sample Protocols

The "Sample" protocols are provided to facilitate learning. Some samples are model
specific.

LHC users: First open the folder that matches your washer model, e.g. 405 Select.
You may need to customize the protocols (as described on page 39) to match your
instrument's settings.

Cell Wash

W-
CELLWASH_
96

Cell wash protocol designed to minimize cell layer disturbance in
96-well plates. Aspirate height increased to 50 steps (approx.
6.35 mm above plate carrier) resulting in increased residual,
approximately 100 µL.

W-
CELLWASH_
384

Cell wash protocol designed to minimize disturbance to cells in
384-well plates. Aspirate height increased to 50 steps (approx.
6.35 mm above plate carrier) will cause increased residual
volume but help to preserve the cell monolayer.

Microplate Manufacturers
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W-Corning_
FLAT

Standard wash protocols modified to best position the manifold
tubes for dispensing and aspirating to Corning Costar flat-
bottomed and round-bottomed wells.

W-Corning_
ROUND

W-NUNC_
384

Standard wash protocols modified to best position the manifold
tubes for dispensing and aspirating to Nunc® flat-bottomed
wells, round-bottomed wells, and 384-well plates.

W-NUNC_
FLAT

W-NUNC_
ROUND

Bead Assays - Biomagnetic Separation and Bottom Filtration

W-Luminex_
MAG_plate_
96

Biomagnetic separation wash protocols designed for optimal bead
recovery in 96-well round- or flat-bottomed plates and 384-well
plates when using BioTek's Flat magnets. Begins by soaking the
plate for 1 minute to let the beads settle at the bottom of the
wells, then performs a 2 cycle wash with 30 second soaks
between cycles.
Recommendation: Determine Magnet Height Offset on page 61
and apply it for the plate you are using, especially when using
384-well plates.

W-Luminex_
MAG_384

W-Luminex_
VAC_96

Vacuum filtration wash protocols for Luminex® xMap polystyrene
bead assays using filter-bottom plates, 96- and 384-well. Protocol
begins with a 5 second bottom aspiration, followed by a 200 µL
dispense for 96-well plates and 75 µL dispense for 384-well, and a
two cycle 200/75 µL wash.

W-Luminex_
VAC_384

Wash Step Parameters Table

Minimally, a wash step includes an aspirate step followed by a dispense step. Select
and define each option to customize the parameters for your assay.

Option Description/Values range Default
values

Number of
wash
cycles:

Each wash cycle first aspirates and then dispenses
fluid to and from the plate.

3
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Option Description/Values range Default
values

Aspirate Vacuum Filtration: Select standard aspiration (Top)
or Vac for filtration.

Filtration
Time:

When applicable, specify duration of vacuum filtration
in seconds. 5-999

30

Travel
Rate:

The rate at which the washer manifold travels down
into the wells. The selection range is 1 to 5 for non-
cell-based assays, from slowest to fastest. With
these rates, the tubes slow their descent as they
approach the defined aspirate height (Z Position) to
aid complete evacuation of the well.

3

For delicate, cell-based assays, the range is 1CW
(cell wash) to 4CW and 6CW. These rates minimize
turbulence in the wells. The tubes descend at a
constant rate to the specified height. Rate 6CW
creates the least disturbance and performs fastest.

Delay: Amount of time the tubes stay at the aspirate height
before lifting out of the wells. Define a delay between
0 - 5000 ms. Increasing the delay may improve
evacuation of the wells.

0

Positioning: X- and Y- horizontal axes, Z- height (vertical) axis
can be adjusted to improve performance. Default Z-
axis for 384-well plates is 22 steps, 2 for 384-well
PCR plates.

Z = 29 for
96-well
plates;
X & Y = 0

Secondary
aspirate:

Also called Crosswise Aspiration. First the wells are
aspirated using the position defined above. The
aspirate tubes rise and then descend to the
secondary position to aspirate again.

No

Dispense

Flow Rate:
96-tube &
192-tube
manifolds

The rate at which the fluid is dispensed from the
tubes. For cell-based assays, use rate 1 or 2 for
gentle washing with the 96-tube manifold only. For
normal dispensing, the range is 3-11, 3 is slowest and
11 is fastest.

7
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Option Description/Values range Default
values

Volume: µL/well dispensed range:
96-tube manifold: 50-3000
192-tube manifold: 25-3000

µL/well:
96= 300
384= 100

Buffer: Buffer bottle selection. A-D A

Positioning: X- and Y- horizontal axes, Z- height (vertical) axis
can be adjusted to improve performance. Default Z-
axis for 384-well plates is 120 steps; 83 for 384-well
PCR plates.

Z = 121 for
96-well
plate

Vacuum
Delay

Suspends the vacuum pump until a certain volume is
dispensed. This feature is critical to cell wash
operations. It delays normal aspiration until the
specified volume has been dispensed to the wells.
The range is 10 to 350 µL/well.

10

Pre-
dispense

Quick, small prime to condition the tips before
dispensing.

No

Flow Rate: 96-tube & 192-tube manifolds: The range is 3-11, 3 is
slowest and 11 is fastest.

9

Volume: µL/tube dispensed range:
96-tube manifold: 50-3000
192-tube manifold: 25-3000

µL/tube:
96 = 50
192 = 25

Bottom
wash

Bottom washing adds an initial wash cycle to the
specified number of cycles. Fluid is simultaneously
dispensed and aspirated to create cleaning
turbulence (at the specified height). The manifold
descends to aspirate again and ends with a final
dispense to fill the wells.

No

Rate: Valid range is 3-11. The cell wash rates, 1 CW and 2
CW, which use low-flow tubing, are available but not
recommended. Cell wash options are designed for
gentle washing, while bottom wash is designed for
vigorous washing.

Wash
Volume:

25-3000 µL/well dispense 250
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Option Description/Values range Default
values

Positioning: X- and Y- horizontal axes, Z- height (vertical) axis
can be adjusted. Repositioning the tubes to harder-
to-reach areas of the wells may the improve results.

Shake To mix the contents of the plate. No

Duration From one second to one hour. 5 sec.

Intensity Intensity Variable cycles through the other
levels of intensitySlow

Medium
Fast

Medium

Soak Delays wash for the duration to allow fluids in the
plate to steep or incubate.

No

Duration From one second to one hour. 30

Home
carrier

To perform the shake or soak in the home position or
not. But, the plate carrier is moved home when the
total duration of the shake and/or soak exceeds 1
minute. The vacuum pump is turned off in this
scenario. Moving the plate home prevents
contaminating it with drops from the manifold.

No

Pre-
dispense
between
cycles

To wet or condition the manifold tubes between
cycles, which is only needed after a long soak. Same
parameters as regular pre-dispense.

No

Final
Aspirate

A final aspiration is performed to completely
evacuate the wells. Same parameters as regular
aspirate step.

Yes

Wash
format

Manner of processing large-format plates Plate

Sector Performs the entire wash step on one sector of the
plate before it moves to the next sector.

Plate Performs each cycle to the entire plate before it
starts the next cycle.
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Operating with the BioStack

If you purchased BioTek’s BioStack Microplate Stacker to operate with the 405 TS,
here is some important information about running it:

LHC Control:

l LHC users: connect both the BioStack and the 405 TS to the computer and control
them with the LHC.

l Design protocols that integrate BioStack controls with 405 TS steps. LHC
protocols must contain a BioStack loop.

l In the LHC, select Help>Tutorials, click Sections in the toolbar for a drop-down
menu, select Controlling the Bio-Stack with LHC. It only takes a couple
minutes to complete this interactive demo. It is a great way to learn about the
special BioStack features offered with the LHC.

Touch screen Control:

l The Quick Wash option does not function with the BioStack, i.e. the BioStack will
not deliver a plate. You must create a protocol to process plates using the
BioStack. Touch screen protocols must contain a BioStack loop.

l You can use the Quick Prime option. This is recommended especially prior to
processing plates, to remove air from the tubing.

l Only one of the 405 TS's communication ports can be used at a time: you
can plug in either the USB cable to connect it to the PC or the serial cable
to connect it to the BioStack (but not to both at the same time).

Install and Align the BioStack:

1. Set up the BioStack according to instructions in your BioStack Operator’s Manual
to interact with the 405 TS. Connect it to the:

l Host computer (PC) when using the LHC to control the 405 TS.

l 405 TS when using the touch screen to control the instrument.

2. Align the BioStack’s gripper with the 405 TS’s plate carrier:
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LHC: Touch screen:

1. Select Tools> BioStack
Utilities.

2. Use the Alignment Utility.

Click the Help button for
detailed instructions.

1. At the Home screen, select
Instrument>Next>BioStack.

2. Fill the BioStack installed checkbox.

3. Press BioStack Alignment to launch
this utility.

3. Set the BioStack operating mode:

LHC:

When controlling the BioStack with the
instrument, you can choose to run the
whole stack or a specific number of plates
at runtime: use the BioStack controls on
the run screen.

Fill the BioStack checkbox in the main
view to enable the BioStack action
buttons and use them to design a
protocol that delivers and retrieves
plates.

5. Verify the setup: perform a protocol with 1 or 2 plates.See How to define a
BioStack protocol on the facing page.

At the start of the day, power up the BioStack first, and then the 405 TS. BIOSTACK2WR:
Lift the BioStack’s gripper before turning it on.

Robotics integrators: CAD drawings of the physical dimensions of the 405 TS are
available upon request. Contact BioTek customer service.

Technical Note: Only one of the two communication ports (COM port) on the
instrument can be used at a time. They cannot be used simultaneously. You

can use USB to connect the 405 TS to the computer or the RS232 serial port to
connect to a BioStack or similar robotic device. But you cannot use both ports
simultaneously, i.e. make sure only one cable is plugged in at a time.
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Use the BioStack

How to define a BioStack protocol

l Select Instrument>Next>BioStack and fill the installed checkbox to
enable the BioStack steps.

Like the Loop, to use the BioStack put the action steps in a step container. First, add
the BioStack step to the protocol and then put the action steps inside the BioStack
start (deliver plate) and end (return plate) steps. Here's an example:

1. Highlight a step or the
<end of steps>
placeholder and press
Add and then
BioStack. This adds a
start step, BioStack
delivers and an end
step, BioStack returns
plate. The end step is
highlighted.

2. Press the desired
action button and
define the parameters
of the steps to be
performed on each
plate.

Make sure the steps to be performed on the plates are inside the 'BioStack
delivers' and 'BioStack returns' steps.

3. Optionally, highlight the <end of steps> placeholder, press Add and add a
Restack step to move the plates back to the input stack. A Restack step must be
outside the BioStack step container.

4. When all the protocol steps are defined, click Validate to make sure the protocol
is correctly designed.

5. Save the protocol.

6. At runtime, define the Number of plates to process in the Run Info section of the
run screen: enter a specific number or select the "Entire input stack" for
processing.
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Re-stack plates in the BioStack

After the plates in the input stack have been processed, they are moved to the
output stack. The Restack step moves them back into the input stack in their
original order.

Important: The Restack step must be outside the "BioStack" step container and it must
follow a container. Only plates previously processed in a BioStack loop can be re-stacked.
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Cell Wash

l Not all 405 TS models support cell wash assays. The dual 96-tube wash
manifold must be installed.

See how to Define a Cell Wash Protocol on the next page. 

Low-flow Fluid Path

The 405 TS supports cell-based assays that require the addition and removal of buffer
solution without disrupting the cells in the wells of the microplate. Cells are often
dislodged when fluid is dispensed at too high a pressure and lost during subsequent
aspiration of the fluid from the well unless counter measures are taken. The 405 TS is
equipped with a low-flow fluid path that provides a "cell wash" alternative for cell-
based assays.
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The low-flow tubing is used during a wash step when the Flow Rate is set to 1 or
2. It dispenses fluid to the wells slowly enough to avoid damaging the cells. Note
that the low flow line is always open, i.e. some fluid flows through the tubing
during normal dispenses. For this reason, priming the low flow tubing is
recommended for all Prime steps.

Additional Techniques

Delay Aspiration: Also critical to cell-based assays is delaying aspiration to allow
the slower dispense process to finish before beginning fluid removal from the well.
This option, offered as part of the dispense step, is called Delay Start of Vacuum.

Adjust the Aspirate Travel Rate and Aspirate Height: when defining the aspirate
step select one of the specially designed travel rates that minimize turbulence in
the wells. Increase the aspirate height to leave more residual fluid in the wells to
protect the cell layer. Also, consider using a secondary aspiration as described in
the Cell Wash Strategies described below.

Adjust the Dispense Flow Rate, Height and Position: when defining the dispense
step be sure to select one of the special Flow Rates that trigger use of the low-flow
tubing, 1 or 2 CW. Also reposition the dispense tubes to aim the fluid at the side of
the wells to further minimize turbulence. See Cell Wash Strategies on the facing page.

Define a Cell Wash Protocol

Adjust the volumes recommended in this procedure to meet your specific needs.

1. Create a new protocol.

2. Add a Prime step, especially when the lines are empty or when
changing fluids.

3. Add a Wash step and define it as you normally would, except
with these special parameters:

l Set the Aspiration Travel Rate to 6 CW and the Delay to 0.

l Set the Dispense Flow Rate to 1 or 2.

l Click the Dispense Advanced Options link and enable the Delay start of
Vacuum until sufficient fluid has been dispensed. For small dispense volumes,
BioTek recommends setting the delay volume to equal your dispense volume.

l Reposition the dispense tubes to aim fluid at the side of the wells to reduce
turbulence and change the aspirate height to increase the amount of residual
fluid left in the well to protect the cell layer. See Cell Wash Strategies on the facing
page.
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Be sure to check the parameters for Final Aspiration.

Cell Wash Strategies

To give you a starting point for optimizing your own assays, here are some
recommendations for improving your cell wash assays:

Repositioning the dispense and aspirate tubes helps minimize turbulence in the
wells, preserving more cells. Using a standard 96-well Corning Costar plate, best
results were achieved with these values:

Dispense Step Settings:
Z - height = 120 steps
X - horizontal position = -45
Y - horizontal position = 0

BioTek Instruments, Inc.



54 | 405 TS Getting Started Guide

Aspirate Step Settings:
Z = 46 steps
X = 35
Y = 0
Secondary Aspirate:
Z = 80 steps
X = -45
Y = 0
About 40 µL/well residual fluid is
retained using these values.

For loosely adherent cells, the best performance was seen by increasing the aspirate
height and using both a standard and secondary (or crosswise) aspiration. Moving the
aspirate tubes from one side of the well to the other prevents a fluid stream from forming
and dislodging the cells. Increased residual in the well means increased cell retention.

Best practice:

l Use the Align tool to determine the optimal X, Y, and Z axis adjustments
needed to best position the manifold above the wells during the wash routine.

l Test the protocol settings by running the protocol using only water and an
empty plate before actually running your assay to make sure the fluid stream
hits the wells as desired.

Delay Aspiration or Vacuum-On Volume Control

Touch Screen Users: Edit the Wash or Dispense Step>Advanced Options

During regular plate washing, aspiration and dispensing occurs simultaneously.
This allows "overflow" dispensing, because the fluid is aspirated before
overflowing the plate. But, the low-flow tubing used in cell wash protocols
dispenses fluid so slowly that aspiration must be delayed to allow the fluid to
reach the well.

405™ TS Microplate Washer



Cell Wash| 55

Use this control to turn on the vacuum pump and begin aspiration only after the
specified volume is dispensed. For cell wash assays, specify at least 10 µL/well. For
small dispense volumes or to disable aspiration for the entire dispense duration, set
the vacuum-on volume to equal your dispense volume. Refer also to application
notes on the BioTek web site for more information (www.biotek.com).

BioTek Instruments, Inc.
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Biomagnetic Separation - Magnetic Bead Assays

The microplate carrier supports placement of a magnet under the microplate. The
magnet induces magnetic beads to settle at the bottom of the wells to help retain
them during a wash protocol’s aspirate cycle.

The 405 TS supports standard microplates and these magnets available for
purchase from BioTek:

Plate Type Magnet PN

96-well 96 Flat Magnet 7103016

96 Ring Magnet 7102216

384-well 384 Flat Magnet 7103017

384 Ring Magnet 7102215

You can use a different magnet if it fits in the carrier and accommodates your
plates. Contact BioTek TAC or visit the Customer Resource Center at
www.biotek.com to obtain a drawing of the carrier with its dimensions.

Persons with pacemakers/implants should avoid direct contact. Keep all
magnetic media, watches, and sensitive electronic devices away from the
magnets. Credit cards, tapes, and disks can be erased in the presence of a
magnetic field. Bodily harm [pinching of hands and skin] can result if magnets
are not handled correctly. Maintain distance between two or more magnets.

Take advantage of the sample magnetic-bead protocols shipped onboard the 405 TS.
Copy W-Luminex_Mag_Flat_96, for example, and modify the parameters to suit your assay
requirements.

Handling and Cleaning the Magnets

For best magnet strength and bead retention, the bottom of the microplate must be
as close to the magnet as possible. We recommend using flat-bottom plates with
minimal support “webbing” between the sides of the outer wells and the plate
skirts.

Handle the magnets with care. Avoid direct contact with the magnet material. Keep
loose ferrous material away and do not attempt to disassemble.
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The magnet should be stored in a cool, dry environment and should be cleaned with
a damp cloth and mild detergent when exposed to harsh solvents. Do not autoclave.

To install the magnet in the proper orientation:

l Flat magnet: place in the plate carrier so the text on the side of the magnet is
readable;

l Ring magnet: place in the plate carrier with the small round magnets visible,
facing upwards.

Realign the BioStack with the Magnet Installed

Using the magnet increases the effective height of the carrier surface (generally by at
least 1 mm). This shift in the plate position requires a comparable adjustment to the
BioStack’s gripper movement. Realign the BioStack before using it with the magnetic
bead assays.

Refer to the BioStack Operator’s Manual for detailed instructions of the alignment
procedure. To help get you started:

1. Place the magnet in the carrier and a microplate on top of it.

2. Launch the BioStack Alignment Utility:

LHC Touch screen

Tools> BioStack Utilities> Alignment Utility Instrument>Next> BioStack

3. HOME the BioStack and Begin Realignment.

4. Lower the claw until a 0.050” (1.3 mm) gap between the bottom of the plate and
the top of the gripper fingers is achieved and save the gripper position.

5. Put the microplate in the input stack and Verify the alignment.

Remember to realign the BioStack for non-bead assays, when applicable.

Perform Magnetic Bead Assays

For the best results when performing biomagnetic separation assays:

l Use the Manifold Stop Screw Adjustment Kit on page 62, if necessary.

l Realign the BioStack with the Magnet Installed on page 57

l Change the Magnet Height Offset on page 60

l Optimize Magnetic Bead Protocols on the next page
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Optimize Magnetic Bead Protocols

Here are some suggestions to consider for optimizing your magnetic bead assays:

l Plate Type: Flat-bottom plates are recommended for magnetic bead assays
because more of their well surface sits closer to the magnet, resulting in
increased magnet strength, than with other plate formats. If you must use
round-bottom plates, increase the between-cycle soak time to improve bead
separation during processing.

l Magnet Height Offset: Deploy this offset to increase the Z-axis or height
setting in all processing options to accommodate the increased height of the
magnet. See Determine Magnet Height Offset on page 61. Use of this feature may
eliminate the need to "Adjust the Aspirate height" described below.

l Shake/Soak Step: Begin the protocol with a delay to let the magnetic beads
settle. Also, specify a mid-cycle soak to let the beads settle after fluid is
dispensed to the plate, e.g. include a 60 second soak before and between
cycles.

Include a 1 second Shake in the first step to best position the plate.

l 6CW Aspirate Travel Rate: select 6CW for the aspirate travel rate. The CW
travel rates are designed to minimize disruption to cell layers on the bottom of
the well. The same principle applies to magnetic bead assays.

l Adjust the Aspirate height: increase the aspirate height setting (Z-axis) which
will increase the residual fluid in the wells but also preserve the beads. Good
results were obtained when keeping the aspirate height around 1.0 mm above
the plate carrier for all but a last Final Aspirate (disabled between cycles).

l Adjust the Aspirate position: When using Flat Magnets below, position the
aspirate tubes near the sides of the wells (X-axis), if possible, to improve bead
retention.

l As always, before running assays, we recommend testing new protocols using
deionized or distilled water and a little Tween® 20 with the desired microplate
and a magnet installed.

Flat Magnets

Use this information about the flat magnets to fine-tune wash protocol settings:

96F Magnet 7103016

384F Magnet 7103017
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The 96- and 384-well magnets are structured differently. Their force fields traverse the
magnet in opposite directions. Magnetic beads in the wells will be drawn to the
center. For the best bead retention, reposition the aspirate tubes in the proper axis:

96-well Flat Magnet PN 7103016

The magnetic force (approx. 6800 Gauss) is
distributed in a horizontal pattern, row-
wise, across the plate. Magnetic beads are
pulled to the center, across the well in flat-
bottom plates and to the button in round-
bottom plates. Increasing the aspirate height
to increase the amount of residual in the
well may improve performance.
Aspirate Settings:

Adjust the Y Position to align the aspirate
tubes near the well walls, if available.
Increase the Aspirate Height (Z axis),
leaving more residual volume in the wells.

384-well Flat Magnet PN 7103017

The magnetic force (approx. 4300 Gauss) is
distributed in a vertical pattern, column-
wise, across the plate.

Adjust the X Position to align the aspirate
tubes away from the center of the well, near
the well walls.

Ring Magnets

Use this information about the VP magnets to fine-tune wash protocol settings:

96 Ring Magnet 7102216

384 Ring Magnet 7102215
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96 Ring Magnet
PN: 7102216

This magnetic bead separator uses
329 of VP’s 52 MGO magnets (7094
Gauss). The magnets are arranged
around each well, pulling the
magnetic beads to the bottoms and
edges of the wells. Aspirate from
the center of the well (the default
position), when using this magnet.

384 Ring Magnet
PN: 7102215

This magnetic bead separator uses
425 of VP’s 52 MGO magnets (6994
Gauss). The magnets are aligned
with the intersections of the wells,
pulling the magnetic beads to the
bottoms and edges of the wells.
Every well is circled by 4 magnets.

Aspirate from the center of the well
(the default position), when using this
magnet.

Magnet Height Offset

When performing magnetic bead assays/biomagnetic separation, this offset setting
is a real time saver. It increases the height or Z-axis for all processing options to
accommodate the increased height of the plate when the magnet is installed.

This setting eliminates the need to modify individual protocol parameters to adjust
the dispense and aspirate heights and enables Quick Wash (without adjustments)
when the magnet is used. It applies the specified height value as an offset to all
relevant steps.

Custom or non-standard microplates and special adapters for labware may benefit from
this setting, too. If a vessel's height has been its only limitation to processing with the 405
TS, i.e. the vessel's geometry permits the manifold tips to successfully address its wells,
this setting can be used to simplify protocol development.

For the best results, measure the height of the plate you are using with the magnet.
BioTek has determined that Nunc flat bottom plates are about 3 mm taller than a similar
Corning plate, for example.
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The "In use" checkbox/option lets you specify and retain
a height setting. Set the value once and then use the control to switch it on and off: fill
the checkbox (keypad users: say Yes) when using a magnet, empty the checkbox
(keypad: No) to disable the offset.

LHC Touch screen

1. Tools> Instrument Utilities> General

2. Fill the In use checkbox and set the
Magnet Adapter height to the correct
offset.

3. Click the Send link.

1. Instrument >Options
2. Fill the Magnet in use checkbox
and enter the Height offset value.

Remove the checkmark to turn off
the offset.

Determine Magnet Height Offset

Use a caliper for the best results or another measuring device.

1. Measure the combined height of the
plate, magnet, and carrier in
millimeters.

2. Measure the plate and the carrier.

3. Calculate the offset: (plate + magnet +
carrier) - (plate + carrier) = Magnet
Height Offset

1. Remove the carrier from the washer.

2. Put a magnet in the carrier and the type of plate you will be using on top of it.

3. Measure the distance from the bottom of the carrier to the top of the plate in
millimeters (mm).

4. Remove the magnet, and measure the plate and carrier combined.

5. Subtract the plate and carrier measurement from the measurement value of the
total combined elements. This is the offset value to use.
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Example:

24.6 mm = 96-well Corning microplate + 96-well flat magnet + plate carrier

- 22.7 mm = 96-well Corning microplate and plate carrier

1.9 mm = Magnet Height Offset

Manifold Stop Screw Adjustment Kit

For Magnetic Bead Assays and 384-Well PCR Plate Processing
To successfully perform these assays, 405 TS Select and HT models may need to
adjust the height of the manifold stop screw. The adjustment kit, PN 1170011, is
shipped with instruments with a dual manifold.

The manifold stop screw prevents the
bottom manifold from touching the
microplate during operation. Sometimes
the screw installed at the factory is too tall
or too short to permit desired processing:

l a taller screw is needed to support a
magnet under the plate for magnetic
bead assays

l a shorter screw is needed to support
processing of 384-well PCR plates that
have a very low profile

Two stop screws can reside in the plate
carrier, making it easier to swap between
them.

Microplate Carrier
Kit Contents:

l Screw height measurement tool (jig)

l Two stop screws with adjustable nuts
and lock washer

l 5/32" Allen (hex) wrench

l Two wrenches - 5/16" and 3/8"

Remove the carrier to perform most of these steps but always perform the
measurement steps with the plate carrier installed correctly on the 405 TS.
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1. In the carrier's empty hole,
insert the taller stop screw
when using a magnet or the
shorter screw when using PCR
plates.

2. Put the magnet and
microplate or the 384-
PCR plate in the carrier on the
instrument. Place the height-
measurement tool (or jig) on
top of the microplate, with the
notched end above the screw.

3. Hold the jig level on top of
the microplate and raise or
lower the stop screw so its
head touches the bottom of
the notch.

4. Set the jig aside. Using your
fingers, hold the stop screw in
place and screw the bottom
nut down until it touches the
microplate carrier.

5. Using the two supplied
wrenches, tighten the bottom
nut to secure the screw, then
tighten the top nut to fully
compress the washer between
them. This will lock the nuts
in place and allow you to
easily remove/replace the
screw without affecting its
height setting.

6. Verify the height with the jig and repeat steps 3-6 if necessary.
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Vacuum Filtration for Filter Plate Assays

With the optional vacuum filtration accessory kit, you can process most standard-
size filter-bottom microplates.

l Install the side bracket

l Set up the Vacuum Filtration module

l Enable Vacuum Filtration

l Install Vacuum Filtration Plate Carrier on page 67

Take advantage of the sample vacuum filtration protocols shipped onboard the 405 TS.
Copy W-Luminex_Vac_96, for example, and modify the parameters to suit your assay
requirements.

Recommendations for best performance:

Here are some guidelines to achieve the best performance of your filter plate
assays:

l Do not use dry filter plates. If dry plates are required by the assay kit
instructions, turn off the Vacuum Filtration sensor to avoid process
interruptions.

l Shake the plate to suspend the beads before aspiration. Enable the wash
cycle option to shake the plate after the dispense and before aspiration. Also
consider creating a multi-step protocol that begins by shaking the plate.

l Experiment with the two parameters, aspiration time and vacuum level, to
determine the best combination of settings for your assay. Start with a brief
time period and low vacuum to avoid lodging the beads in the filter material.

l Maintain consistent vacuum during the process with a tight seal:
l Use new or defect-free filter plates and make sure they are seated
perfectly in the carrier;

l Make sure all tubing is connected correctly, and leak-free.

Expect to spend some time experimenting with different pressure settings. Follow
the filter plate manufacturer's recommendations, if available. Generally, bead
assays prefer low pressure and DNA separation assays prefer higher pressure. The
best performance in tests at BioTek were seen when the pressure was set to 2.5
inHg.
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Create a Vacuum Filtration Protocol

You may want to begin the protocol with a Shake step to suspend the beads.

LHC: Touch screen

1. Click (or select File>New).

2. Select the plate type.

3. Specify a Protocol Name.

4. Click

5. Click Show Wash Options

6. Fill the checkbox for Vacuum Filtration
and specify the vacuum duration, Time.
Optionally, do the same for the Final
Aspirate.

1. Select Define>Create.

2. Touch the Name field and enter
a unique protocol name. Press
OK.

3. Press Add and selectWash (or
Soak to begin with a Shake
step).

4. Enable Vacuum Filtration in the
Aspirate step and set the
vacuum duration.

5. Define the Final Aspirate
parameters.

7. Fill the checkbox for Shake/Soak and
specify the shake duration.

Experiment with different settings to determine the optimal parameters to meet your
goals.
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l Important: Be sure to change the Plate Carrier setting to match the
installed carrier.

Remember to specify the type of aspiration to perform in a Final Aspirate.

Control the Vacuum Level

Vent plugs stored on side of carrier

Change the vent plug to control the vacuum level

The vacuum filtration plate carrier has a vent and ships with four vent plugs to
vary the vacuum levels:

Plug Vent Diameter Vacuum Level mmHg kPa

No plug 0.067” (1.70 mm) Lowest -32 -4.3

Beige with hole 0.047” (1.19 mm) Low -118 -15.7

Gray 0.032” (0.81 mm) Medium -187 -24.9

Black 0.020 (0.51 mm) High -382 -50.9

Beige (solid) 0.00 Highest -567 -75.5

Leave the vent open for the least amount of vacuum. Insert one of the plugs to
increase vacuum.
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l Vacuum pressure is affected by several factors like relative humidity,
barometric pressure, and mechanical tolerances, as well as, filter plate
pore size

Testing at BioTek confirmed expectations: small pore filter plates and highly viscous
fluids require increased vacuum and/or longer aspiration durations to evacuate the
wells.

Install Vacuum Filtration Plate Carrier

Vacuum Filtration Plate Carrier (and bracket for holding tubing)

1. Locate the longest length of tubing shipped with the module. It is made from two
tubes joined by a rigid connector.

2. Connect the shorter end to the special plate carrier for vacuum filtration.

3. Connect the longer end to the control module port labeled To Vacuum Filtration
Carrier.

4. Tuck the rigid connector into the bracket you installed on the side of the
instrument.

5. Change the instrument setting:
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LHC Touch screen

1. Select Tools>
Instrument Utilities.

2. For Plate Carrier
Selection, select Vacuum
Filtration.

1. Press Instrument >
Options

2. Set the Plate Carrier to
Vacuum Filtration.

Note: Make sure Vacuum Filtration is "enabled" to select the special plate carrier:
Instrument>Options>Advanced Settings.

Important: Always set the carrier selection to match the installed hardware, regardless
of the type of plate processing you are doing. You can perform a regular wash (non-filter
plates) using the vacuum filtration carrier.

Changing the Instrument's Settings

About the Onboard Settings

The instrument's onboard settings dictate its behavior. Certain settings, like Plate
Clearance, can improve performance. Other settings are critical to its performance.
For example, the manifold setting must match the installed manifold type.

LHC users: do not confuse the LHC's Target Instrument Settings assigned to each
protocol with the onboard settings! Review the Help topic: LHC Protocols Explained to learn
the distinctions.

To change the onboard settings:

LHC Touch screen

1. Select Tools>Instrument
Utilities

2. Choose the applicable tab and
modify settings as desired.

3. Click Send after changing a
setting to update the
instrument.

1. Press
Instrument>Options
for washer settings.

2. Explore the other tabs
for more settings.

l When using the LHC to change instrument settings, you may need to
reboot the 405 TS before controlling it with the touch screen.
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Washer Settings

Touch screen: Instrument>Options

Manifold Selection

After physically changing the manifold, tell the 405 TS which manifold is installed:

l 96-tube: single manifold for 96-well plates only or dual manifolds to process 96-
and 384-well plates.

l 192-tube: only 384-well plates.

Magnet Height Offset

When performing magnetic bead assays/biomagnetic separation, this offset setting is
a real time saver. It increases the height or Z-axis for all processing options to
accommodate the increased height of the plate when the magnet is installed.

This setting eliminates the need to modify individual protocol parameters to adjust
the dispense and aspirate heights and enables Quick Wash (without adjustments)
when the magnet is used. It applies the specified height value as an offset to all
relevant steps.

Custom or non-standard microplates and special adapters for labware may benefit from
this setting, too. If a vessel's height has been its only limitation to processing with the 405 TS,
i.e. the vessel's geometry permits the manifold tips to successfully address its wells, this
setting can be used to simplify protocol development.

Sensors Enabled

l Important: The washer must be primed, tubes filled, prior to a run.

l These sensors cannot detect the depletion of fluid in the supply vessel during a
protocol step. Fill the supply bottle(s) with sufficient fluid to fully prime the
system and complete the protocol.

Fluid Detection: measures the fluid level at the beginning and completion of a
wash cycle, dispense and AutoClean step. An error before the run suggests
insufficient fluid to begin. An error at the end of the run may indicate that less
volume than specified was dispensed.

Flow Detection: monitors fluid flow during the run and issues a warning if the
pump is interrupted. An error indicates a problem with the pump.

Filter Vacuum Detection: built into the vacuum filtration module, this sensor
detects errors in the setup of the vacuum filtration system, including disconnected
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tubing, loose bottle cap, missing filter plate, non-functioning internal vacuum
pump and extremely low vacuum. This sensor is disabled by default.

Plate Detection: washers with Verify™ Technology offer this sensor to detect the
presence of a microplate on the plate carrier before every protocol run. BioStack
users: the sensor checks for the first plate in the stack only.

BioTek recommends keeping the detection systems activated. Exceptions:

l Deactivate the Waste sensor when using BioTek's Direct Drain Waste System.

l When vacuum filtration assays need to be performed at very low vacuum
levels, e.g. no plug, but the washer displays an error, deactivate the sensor:
LHC - "Filter Vacuum" or Touch screen - "Vac Filtr".

l When running the system using air instead of fluid to dry out the components
before shipping or long-term storage, if error messages interrupt the
procedure, deactivate the fluid and flow sensors.

AutoPrime

Recommended for optimum performance, AutoPrime keeps the tubing wet in
between runs and can be an essential part of your daily maintenance routine.

About AutoPrime

AutoPrime automatically primes the tubing whenever the instrument is idle for a
specified time. Keeping the tubes wet prevents clogging and mitigates fluid
evaporation at the tips. AutoPrime's submerge feature lets you soak the tubes for
extended periods, which is an effective maintenance option.

Specify the Interval and AutoPrime Parameters

AutoPrime runs at the Home screen when the instrument has been idle for a
specified interval.

To set the AutoPrime Interval:
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LHC: Touch screen:

1. Select
Tools>Instrument
Utilities> AutoPrime
tab.

2. Specify the idle-time
interval that will trigger
an AutoPrime; up to 24
hours.

3. Enable and define the
parameters. Remember to
set a Submerge Duration
to employ this option.

4. Click Send to transfer the
settings to the instrument.

1. Select Instrument at the Home
screen and select AutoPrime.

2. Specify the idle-time interval
that will trigger an AutoPrime;
up to 24 hours in minutes.

3. Set the Submerge Duration, if
desired.

4. Define the AutoPrime
parameters: rate, volume, and
buffer valve, if applicable.

BioStack

Important: The BioStack must be connected to the 405 TS using the dedicated serial cable
shipped with the BioStack and turned on.

l Get Basecode: this is good communication test. Check the cabling, and make
sure the BioStack is turned on if the basecode version is not revealed.

l BioStack Alignment: after setting up the 405 TS and BioStack to interface with
each other using the alignment hardware provided and following instructions in
the BioStack Operator's Manual, you are ready to use this alignment utility to tell
the BioStack precisely where to place and retrieve microplates.

BioStack Alignment Utility

Follow the detailed procedure in the BioStack Operator's Manual to use this
alignment utility to precisely align the BioStack's gripper with the microplate carrier:
First install the alignment hardware, correctly position the instruments in their
respective aligning plates, and connect the instruments with the dedicated serial cable
before attempting to align the gripper with the washer.
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Begin by pressing Home to enable the alignment and step up and down buttons.
When the gripper appears to be correctly positioned, Save (the) Position and
proceed with the Verify procedure.

Press the previous button to exit the screen.

Get protocols from a memory stick - USB drive

Important: Put the protocols you want to transfer to the washer in a folder called
Protocols. The 405 Touch expects to find a Protocols folder on the memory stick.

You can exchange 405 TS protocols with other users, copy protocols from one
washer to another, or obtain sample protocols from BioTek's website using a
USB stick:

1. Insert the memory stick into the USB port on top of the washer.

2. Select Instrument>Next>Other from the Home screen.

3. Press Transfer Protocols.

4. Choose the File Source: USB to copy protocols from it to the washer.
(Conversely, choose Internal to copy protocols to the flash drive to share them
with another instrument.)

5. Optionally, apply the Lock files option to prevent users from changing the
protocols.

6. Select files individually by highlighting them (touch) or transfer all protocols
simultaneously.

Locked files: you can "unlock" a protocol by replacing it using the Protocol Transfer
control. Upload the protocol to a USB stick, make sure "Lock files" is disabled and re-
transfer the protocol. It will overwrite the existing file.

Watch a training video

The 405 TS offers a simple video viewer to show short videos from BioTek. The
video player is useful only for BioTek-provided videos with restricted frame
speeds and the Windows file format: .wmv.

1. Insert the USB flash drive containing the video file into the USB port.

2. Select Instrument>Next>Other from the Home screen.
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3. Press Show Video.

4. Highlight the .wmv file and press Select.
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Regular maintenance is required to achieve optimal
performance with the 405 TS. This section provides guidelines
and instructions for basic daily maintenance and the
Recommended Maintenance Schedule. Find comprehensive
instructions for performing regular maintenance in the
operator's manual.
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Overview

A Preventive Maintenance (PM) regimen for the 405 TS includes rinsing and
soaking the fluid path and cleaning and/or autoclaving the various components.
The level of maintenance required to keep the instrument performing as expected
is dependent on several factors, including the type of fluid dispensed, the
frequency of use, and the work habits employed.

The Recommended Maintenance Schedule on the facing page summarizes BioTek’s
recommended maintenance tasks, and indicates approximately how often each task
should be performed. Daily and periodic routines and minimal guidelines for
frequency are listed. Beyond that, it is difficult for BioTek to recommend a fixed
frequency for each task to be performed. The frequency of conducting these tasks
must be based on the risk and performance factors of your assays.

Develop a maintenance schedule for your 405 TS based on the characteristics of the
fluids used and the activity level. Here are some guidelines for each component:

Washer

l When using fluids prone to dry and harden quickly, the washer’s dispense
and aspirate tubes can clog quickly, and must be rinsed frequently and
cleaned regularly. Run AutoClean ultrasonic cleaning regularly, when
available.

l If the washer will be idle for several hours or days at a time, soak the
tubes to keep them in a ”wetted” state. Enable AutoPrime if the washer
is idle for more than 3 hours.

l Wash solutions affect the rinse frequency. If the solution does not
contain surfactant, consider rinsing (or running AutoPrime) at least
once an hour.

Recommended Maintenance Schedule

The schedule recommends preventive maintenance tasks, the frequency with which
each task should be performed, and the predefined onboard Maintenance program
that should be run (if applicable). See Recommended Maintenance Schedule on the
facing page.

l It is important to note that the risk and performance factors associated
with your assays may require that some or all of the procedures be
performed more frequently than suggested in this schedule.
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Recommended Maintenance Schedule

Tasks

Frequency

Daily Overnight/
Multi-Day

Weekly Periodic/
Monthly

Before
storage/
shipment

Run W-DAY_RINSE ü ü

Run AutoPrime ü

Run W-OVERNIGHT_LOOP ü

Run W-RINSE_AND_SOAK ü

Run Verify™ clog detection
test

ü

Run AutoClean ü ü

Components

Remove protein residuals and
fungi growth, (if necessary)

ü ü ü

Check/empty waste bottles ü ü

Clean bottles ü ü

Clean plate carrier system ü ü

Clean washer manifold ü ü

Clean aspirate and dispense
tubes

ü ü

Clean exterior surfaces and
mist shield

ü

Clean fluid inlet filter ü ü

Clean vacuum filtration
system

ü ü

Clean the Verify™ level sensor ü ü

Decontaminate
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Tasks

Frequency

Daily Overnight/
Multi-Day

Weekly Periodic/
Monthly

Before
storage/
shipment

Decontaminate external
surfaces

ü ü

Run W-DECONTAMINATE ü ü

Decontaminate vacuum
filtration system

ü

Prepare for Storage or Shipment

Run W-LONG_SHUTDOWN ü

Replace/Repair Components

Replace the Verify Test Plate As Needed

405™ TS Microplate Washer



Daily Maintenance| 79

Daily Maintenance

Daily maintenance involves flushing the washer with an appropriate reagent or
deionized water throughout the day.  Routine rinsing helps to prevent the aspirate
and dispense tubes from clogging between runs. Flushing the devices with deionized
water is recommended at the end of the day for most applications.

The recommended rinsing frequency depends on the solutions currently in use: 

l When a solution containing surfactant is used throughout the day, perform the
rinsing procedure when the device is idle for more than 3 hours.

l When the solution does not contain surfactant, consider rinsing at least once an
hour.

Run this protocol and enable AutoPrime to satisfy the daily maintenance
requirements:

l W-DAY_RINSE

Make sure the supply bottles contain sufficient rinse solution and that the waste
bottles are empty before running the protocols.  

Also see the additional maintenance procedures required when dispensing protein
solutions: Removing Protein Residuals and Fungi Growth on page 82.

AutoPrime

AutoPrime automatically conditions the dispense tubes, priming them with the
specified volume, after a user-specified amount of idle time.

l Press the STOP button to interrupt the AutoPrime routine when it is underway.

l Any interaction with the instrument via the touch screen or the LHC resets the
interval clock.

Overnight/Multi-Day Maintenance

Overnight/multi-day maintenance involves flushing all solutions out of the
instrument, and then periodically rinsing and soaking the tubes to keep them moist.
Here are three recommendations for accomplishing the task. Employ the method that
best suits your work flow:
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Overnight Loop

To keep the wash manifolds in a wetted condition, you can run these predefined
protocols to soak the tubes for several hours at a time:

l W-OVERNIGHT_LOOP: requires the washer to remain turned on.

l W-RINSE_AND_SOAK: alternatively, run this protocol and turn off the
instrument after the soak begins. The tubes will soak in the priming trough
until the instrument is turned on again.

AutoClean the Washer

Some models of the 405 TS feature BioTek's Ultrasonic Advantage™ for easy and
thorough cleaning of the wash manifold. Instruments with AutoClean capability are
easily identified by the stainless steel priming reservoir built into the instrument's
base, under the wash manifold.

Warning!   Ultrasonic energy is present in the cleaning reservoir when the
AutoClean program is running. Do not put your fingers in the bath! Ultrasonic
energy can harm human tissue.

l Important! Ensure there is adequate room in the waste bottle and
sufficient volume in the supply bottle before running AutoClean!

Tip: Detergent such as Terg-A-Zyme® added to deionized water in the supply bottle
helps to break down the water’s surface tension and enhances the cleaning process. Terg-
A-Zyme also contains protease enzyme for assimilating protinaceous residue such as
bovine serum albumin (BSA).

About AutoClean

BioTek's Ultrasonic Advantage™ is a built-in ultrasonic cleaner that provides
enhanced maintenance capabilities by using ultrasonic pulses in a water bath to
clean the manifold tubes. Ultrasonic energy causes cavitation forces within the
water bath, which in turn cause tiny vapor bubbles to be created. The formation
and subsequent collapse of these bubbles is the mechanism that cleans the
manifold tubes submerged in the bath.

The cleaner consists of a stainless steel reservoir with an ultrasonic transducer
bonded to the bottom of the reservoir. The reservoir is mounted under the washer
manifold and also functions as the priming trough.
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l Do not try to remove the ultrasonic cleaner! Only BioTek authorized
service personnel should remove the ultrasonic cleaner for maintenance
or repair.

While the program is running, the ultrasonic cleaner will pulse on and off
approximately every ten seconds, and you will hear a periodic hissing sound that
indicates the ultrasonic energy is present. 

l Not all 405 TS models are equipped with this feature.

Quick Clean

A the Home screen selectQuick>Sonicate Manifold

Take advantage of the 405 TS's "Ultrasonic Advantage" to make sure the manifold
tubes are clean and clog-free.

1. Fill the "Clean Buffer" bottle with detergent or an appropriate solution for your
assay. The 405 TS primes the system with 300 mL/305 mL for CW models and
fills the trough with 93 mL for the sonicator. Buffer Switching models: connect it to
the specified valve.

2. Set the desired duration to soak the tubes and run the sonicator.

3. Fill the "Rinse Buffer" bottle with at least 305 mL of deionized or distilled water
and/or with a wash buffer to leave the instrument primed and ready for use.
Buffer Switching models: connect it to the specified valve.

4. When you're ready, press Start.

Warning!   Ultrasonic energy is present in the cleaning reservoir when the
AutoClean program is running. Do not put your fingers in the bath! Ultrasonic
energy can harm human tissue.

l Important! Ensure there is adequate room in the waste bottle and
sufficient volume in the supply bottle before running AutoClean!

Submerge and Shutdown

An overnight/multi-day maintenance option for soaking the tips and turning off the
instrument for overnight and weekend maintenance.

You can soak the 405 TS dispense manifolds by filling the priming troughs and
turning off the instrument after the soak begins. The tubes will soak in the priming
troughs until the instrument is turned on again.
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1. RunW-RINSE_AND_SOAK.

2. When the wash manifold is submerged, turn off the instrument.

5. Run a System Self-Test to empty the washer's priming trough when restarting
the instrument.

Removing Protein Residuals and Fungi Growth

Important! Solutions containing proteins, such as bovine serum albumin
(BSA), will compromise the 405 TS’s performance over time unless a strict
maintenance regime is adhered to. Do not use isopropyl alcohol to flush out
BSA.

When using protein solutions or similar fluids, BioTek recommends performing the
following additional Maintenance procedures to thoroughly flush out protein
particles and other contaminants from the fluid path.

Daily Practice with buffer or deionized water:

If the 405 TS will be idle between plates for longer than 45 minutes, flush the
proteins:

1. Fill a supply bottle with deionized water. Connect the bottle to the washer.
(Buffer valve “A” for Buffer Switching models)

2. Run the W-DAY_RINSE protocol.

3. Enable AutoPrime for 60-minute intervals.

At the end of the day:

1. Fill a supply bottle with deionized water. Connect the bottle to the washer
(Buffer valve “A” for Buffer Switching models).

2. Run the W-DAY_RINSE protocol three times.

3. Perform your regular Overnight/Multi-Day Maintenance routine.

Weekly or As Needed use NaOH and HCl to remove proteins:

1. Flush the system with 0.1-0.5 N* NaOH (sodium hydroxide), followed by
neutralization with an equivalent normality (0.1-0.5 N) of HCl (hydrochloride).

2. Rinse well with deionized water to remove the HCl.

3. Run the applicable DAY_RINSE protocol three times with deionized water if
you plan to use the device immediately.
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l * N = Normal solution, which contains 1 ‘gram equivalent weight’ (gEW) of
solute per liter of solution. The gram equivalent weight is equal to the
molecular weight expressed as grams divided by the ‘valency’ of the
solute.

Alternatively use an Enzyme-Active Detergent:

1. Mix an enzyme-active detergent according to the manufacturer’s directions to fill
a four-liter supply bottle. Connect the bottle to the washer’s Buffer valve A.
Connect a bottle of deionized or distilled water to Buffer valve B to rinse the
tubing.

2. Run the W-DECONTAMINATE protocol, as appropriate.

3. Respond to the Delay message, “Connect a bottle of water…”, leave the detergent
bottle connected and when ready, press Continue.

4. When the protocol is completed, connect a bottle containing four liters of
deionized water and run W-DAY_RINSE three times to flush the system.

Clean the Buffer Bottle Filter

Periodically clean the buffer bottle filter (PN 01310):

l Perform this task when the buffer bottle is empty or over a sink to catch
spillage.

1. Open the buffer bottle
and lift the cap and its
tubing up and out of
the bottle.

2. Remove the fluid filter
at the bottom of the
tubing.

3. Wash the filter with
hot water and a soft-
bristled brush, if
necessary.

4. Rinse the filter and
reinstall it.
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Hazards and Precautions

Hazards

The following hazards are provided to help avoid injury:

Warning! Power Rating. The instrument’s power supply or power cord
must be connected to a power receptacle that provides voltage and
current within the specified rating for the system. Use of an incompatible
power receptacle may produce electrical shock and fire hazards.

Warning! Electrical Grounding. Never use a two-prong plug adapter
to connect primary power to the external power supply. Use of a two-
prong adapter disconnects the utility ground, creating a severe shock
hazard. Always connect the power cord directly to an appropriate
receptacle with a functional ground.

Warning! Service. Only qualified technical personnel should perform
service procedures on internal components.

Warning! Accessories. Only accessories which meet the manufacturer’s
specifications shall be used with the instrument.

Warning! Lubricants. Do not apply lubricants to the microplate carrier or
carrier track. Lubricant on the carrier mechanism will attract dust and
other particles, which may obstruct the carrier path and cause the
instrument to produce an error.

Warning! Liquids. Avoid spilling liquids on the instrument; fluid
seepage into internal components creates a potential for shock hazard
or instrument damage. If a spill occurs while a program is running, abort
the program and turn the instrument off. Wipe up all spills immediately.
Do not operate the instrument if internal components have been
exposed to fluid.

Warning! Unspecified Use. Failure to operate this equipment
according to the guidelines and safeguards specified in this manual could
result in a hazardous condition.

Warning! Direct Drain Waste. If installed, the direct drain waste
system pumps waste fluids from the washer directly into a sink or tank,
and, potentially into public waste water systems. Because the waste
may be a biohazard, you must ensure that you are in compliance with
your local or national government’s laws regarding safe disposal of the
waste.
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Warning! Ultrasonic Energy. Ultrasonic energy is present in the
ultrasonic cleaner reservoir (if equipped) when AUTOCLEAN/Quick Clean
programs are running. Avoid putting your fingers in the bath. Ultrasonic
energy can be destructive to human tissue.

Warning! Software Quality Control. The operator must follow the
manufacturer’s assay package insert when modifying software
parameters and establishing washing or dispensing methods. Failure to
conduct quality control checks could result in erroneous test
data.
Warning! Internal Voltage. Always turn off the power switch and
unplug the power supply before cleaning the outer surface of the
instrument.

Warning! Potential Biohazards. Some assays or specimens may
pose a biohazard. Adequate safety precautions should be taken as
outlined in the assay’s package insert. This hazard is noted by the
symbol shown here. Always wear safety glasses and appropriate
protective equipment, such as chemically resistant rubber gloves and
apron.

Warning! Pinch Hazard. Some areas of the instrument or its
components can present pinch hazards when the instrument is
operating. Depending on the instrument or component, these areas are
marked with the symbol shown here. Keep hands/fingers clear of these
areas when the instrument is operating.

Precautions

The following precautions are provided to help avoid damage to the instrument:

Caution: Service. The instrument should be serviced by BioTek
authorized service personnel. Only qualified technical personnel should
perform troubleshooting and service procedures on internal components.

Caution: Spare Parts. Only approved spare parts should be used for
maintenance. The use of unapproved spare parts and accessories may
result in a loss of warranty and potentially impair instrument performance
or cause damage to the instrument.
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Caution: Environmental Conditions. Do not expose the instrument to
temperature extremes. For proper operation, ambient temperatures
should remain within the range listed in the Specifications section.
Performance may be adversely affected if temperatures fluctuate above
or below this range. Storage temperature limits are broader.

Caution: Sodium Hypochlorite. Do not expose any part of the
instrument to the recommended diluted sodium hypochlorite solution
(bleach) for more than 20 minutes. Prolonged contact may damage the
instrument surfaces. Be certain to rinse and thoroughly wipe all surfaces.

Caution: Buffer Solution. Although many precautions have been taken
to ensure that the instrument is as corrosion-proof as possible, the
instrument is not sealed and liquids can seep into sensitive components.
Make sure that any spilled buffer solution is wiped off the instrument.
Prolonged exposure to salt solution may corrode parts of the microplate
carrier, movement rail, springs, and other hardware.

Caution: Chemical Compatibility. Some chemicals may cause
irreparable damage to the instrument. The following chemicals have been
deemed safe for use in the instrument: buffer solutions (such as PBS),
saline, surfactants, deionized water, 70% ethyl, isopropyl, or methyl
alcohol, 40% formaldehyde, and 20% sodium hydroxide. Never use acetic
acid, DMSO, or other organic solvents. These chemicals may cause severe
damage to the instrument. Contact BioTek for more information and prior
to using other questionable chemicals.

Caution: Bovine Serum Albumin. Solutions containing proteins, such
as bovine serum albumin (BSA), will compromise the instrument’s
performance over time unless a strict maintenance protocol is adhered to.
See Maintenance procedures regarding BSA.
Caution: Power Supply. Only use the power supply shipped with the
instrument. Operate this power supply within the range of line voltages
listed on it.

Caution: Disposal. This instrument contains printed circuit boards and
wiring with lead solder. Dispose of the instrument according to Directive
2002/96/EC, “on waste electrical and electronic equipment (WEEE),” or
local ordinances.

Caution: Warranty. Failure to follow preventive maintenance protocols
may void the warranty.
Caution: Shipping Hardware. All shipping hardware (e.g., shipping
bracket etc.) must be removed before operating the instrument and
reinstalled before repackaging the instrument for shipment.
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Caution: High Flow Pump Installation. DO NOT plug the High Flow
vacuum pump cable into a wall outlet!  Use the adapter provided with the
pump to connect the pump to the accessory outlet on the back of the
washer. See the Installation instructions.
Caution: Waste Sensor Port on 405 TS. (For customers who have
purchased the BioStack Microplate Stacker.) Although the waste sensor
port on the back of the 405 TS is the same type as the 24-VDC power
connector on the back of the BioStack, if an external 24-VDC power
supply is plugged into the 405 TS’s port, it will permanently damage
internal components.
Caution: Electromagnetic Environment. Per IEC 61326-2-6 it is the
user’s responsibility to ensure that a compatible electromagnetic
environment for this instrument is provided and maintained in order that
the device will perform as intended.

Caution: Electromagnetic Compatibility. Do not use this device in
close proximity to sources of strong electromagnetic radiation (e.g.,
unshielded intentional RF sources), because these may interfere with the
proper operation.

CE Mark

Based on the testing described below and information
contained herein, this instrument bears the CE mark.

l Note: See the Declaration of Conformity for specific information.

Directive 2004/108/EC: Electromagnetic Compatibility

Emissions—Class A

The system has been type-tested by an independent, accredited testing laboratory
and found to meet the requirements of EN 61326-1: Class A for Radiated Emissions
and Line Conducted Emissions.

Verification of compliance was conducted to the limits and methods of EN 55011
(CISPR 11) Class A. In a domestic environment it may cause radio interference, in
which case, you may need to mitigate the interference.

Immunity

The system has been type-tested by an independent, accredited testing laboratory
and found to meet the requirements of EN 61326-1 and EN 61326-2-6 for Immunity.
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Verification of compliance was conducted to the limits and methods of the
following:

EN 61000-4-2, Electrostatic Discharge

EN 61000-4-3, Radiated EM Fields

EN 61000-4-4, Electrical Fast Transient/Burst

EN 61000-4-5, Surge Immunity

EN 61000-4-6, Conducted Disturbances from RFI

EN 61000-4-11, Voltage Dips, Short Interruptions and Variations

Directive 2006/95/EC Low Voltage (Safety)

The system has been type-tested by an independent testing laboratory and was
found to meet the requirements of this Directive. Verification of compliance was
conducted to the limits and methods of the following:

EN 61010-1, “Safety requirement for electrical equipment for measurement,
control and laboratory use. Part 1, General requirements.”

EN 61010-2-081, “Particular requirements for automatic and semi-automatic
laboratory equipment for analysis and other purposes.”

Directive 2002/96/EC: Waste Electrical and Electronic Equipment

Disposal Notice: This instrument contains printed circuit boards and wiring with
lead solder. Dispose of the instrument according to Directive 2002/96/EC, “on
waste electrical and electronic equipment (WEEE)” or local ordinances.

Directive 98/79/EC: In Vitro Diagnostics (if labeled for this use)

l Product registration with competent authorities.
l Traceability to the U.S. National Institute of Standards and Technology (NIST).

EN61010-2-101Particularrequirements forinvitrodiagnostic (IVD)medical
equipment.

Electromagnetic Interference and Susceptibility

USA FCC CLASS A

RADIO AND TELEVISION INTERFERENCE
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NOTE: This equipment has been tested and found to comply with the limits for a
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to
cause harmful interference, in which case the user will be required to correct the
interference at their own expense.

In order to maintain compliance with FCC regulations shielded cables must be
used with this equipment. Operation with non-approved equipment or unshielded
cables is likely to result in interference to radio and television reception.

Canadian Department of Communications Class A

This digital apparatus does not exceed Class A limits for radio emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadian
Department of Communications.

Le present appareil numerique n'émet pas de bruits radioelectriques depassant
les limites applicables aux appareils numerique de la Class A prescrites dans le
Reglement sur le brouillage radioelectrique edicte par le ministere des
Communications du Canada.

User Safety

This device has been type-tested by an independent laboratory and found to meet the
requirements of the following:

l Underwriters Laboratories UL 61010-1 “Safety requirements for electrical
equipment for measurement, control and laboratory use; Part 1: general
requirements.”

l Canadian Standards Association CAN/CSA C22.2 No. 61010-1 “Safety
requirements for electrical equipment for measurement, control and laboratory
use; Part 1: general requirements.”

l EN 61010 Standards, see CE Mark on page 89.
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Safety Symbols

Some of these symbols appear on the instrument or accessories:

Alternating current
Courant alternatif
Wechselstrom
Corrientealterna
Correntealternata

Both direct and alternating current
Courant continu et courant alternatif
Gleich - undWechselstrom
Corriente continua y corrientealterna
Corrente continua e
correntealternata

Direct current
Courant continu
Gleichstrom
Corriente continua
Corrente continua

Earth ground terminal
Borne de terre
Erde (Betriebserde)
Borne de tierra
Terra (difunzionamento)

On (Supply)
Marche (alimentation)
Ein (VerbindungmitdemNetz)
Conectado
Chiuso

Protective conductor terminal
Borne de terre de protection
Schutzleiteranschluss
Borne de tierra de protección
Terra diprotezione

Off (Supply)
Arrêt (alimentation)
Aus (TrennungvomNetz)
Desconectado
Aperto
(sconnessionedallaretedialimentazio
ne)

Caution (refer to accompanying
documents)
Attention (voir documents
d’accompanement)
AchtungsieheBegleitpapiere
Atención (vease los
documentosincluidos)
Attenzione, consultare la doc annessa

Warning, risk of electric shock
Attention, risque de choc électrique
Gefährlicheelektrischeschlag
Precaución, riesgo de
sacudidaeléctrica
Attenzione, rischiodiscossaelettrica

Warning, risk of crushing or pinching
Attention, risqued’écrasement et
pincement
Warnen, Gefahr des Zerquetschens
und Klemmen
Precaución, riesgo del
machacamiento y sejeción
Attenzione,
rischiodischiacciareedintrappolarsi

Warning, hot surface
Attention, surface chaude
Warnen, heißeOberfläche
Precaución, superficiecaliente
Attenzione, superficiecalda

Warning, potential biohazards
Attention,
risquesbiologiquespotentiels
Warnung!
MoeglichebiologischeGiftstoffe
Atención, riesgosbiológicos
Attenzione, rischiobiologico
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In vitro diagnostic medical device
Dispositif médical de diagnostic in
vitro
Medizinisches In-Vitro-Diagnostikum
Dispositivo médico de diagnóstico in
vitro
Dispositivo medico diagnostico in
vitro

Separate collection for electrical and
electronic equipment
Les équipements électriques et
électroniques font l’objet d’une
collecte sélective
Getrennte Sammlung von Elektro-
und Elektronikgeräten
Recogida selectiva de aparatos
eléctricos y electrónicos
Raccolta separata delle
apparecchiature elettriche ed
elettroniche

Consult instructions for use
Consulter la notice d’emploi
Gebrauchsanweisung beachten
Consultar las instrucciones de uso
Consultare le istruzioni per uso
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Troubleshooting

Error recovery:

First Response: Run a System Test (restart the instrument) to give the instrument
an opportunity to restore its initial settings and communication capability.

LHC Users: Reboot your Computer and Instrument: When you cannot run a
system test, e.g. LHC is not responding, or when running a system test doesn't
resolve the issue, turn off your computer and 405 TS, check all the cabling, i.e.
make sure your USB cable is in good condition and is properly connected to the PC
and instrument, and then, power them on. This should refresh the devices and reset
communication parameters.

Error Codes

To find a specific error code:

l Software Error Codes (6000-6100) - protocol errors

l System Error Codes (0000-A500) - hardware errors
Most error conditions generate an error message that is displayed on the computer
screen or keypad.

6045 Serial write error

LHC Users: A potentially common error, especially when using the Predefined
Protocols, a "serial write" error, is easily fixed by correcting the COM port setting
defined in the protocol.

810D To communicate, instrument must be at main menu/Home screen.

LHC Users: Similarly, the 810D message appears when the instrument is busy, for
example when AutoPrime is running. The LHC can only talk to the instrument
when its Home screen is displayed. Press the Stop button, if desired, to end the
current process and reestablish communication with the LHC.

BioStack Errors: To recover from a BioStack error, remove the plate from the
BioStack's tray, if applicable, and Home the stacker using the alignment utility:
select Instrument>Next>BioStack from the Home screen. Press BioStack
Alignment and then Home.

Technical Note: Only one of the two communication ports (COM port) on the
instrument can be used at a time. They cannot be used simultaneously. You
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can use USB to connect the 405 TS to the computer or the RS232 serial port to connect
to a BioStack or similar robotic device. But you cannot use both ports
simultaneously, i.e. make sure only one cable is plugged in at a time.

Washer Problems

Review these suggestions to correct problems your washer is having:

l Vacuum Pump Problems on page 102

l Fluid Aspiration on the next page

l Fluid Delivery on page 98

l Fluid Leakage on page 100

l Washer Manifold Movement on page 101

Microplate Carrier Movement

Problem Possible
Cause What To Do

Aspiration
tubes not
entering
wells
correctly.

Microplate not
properly
seated or
strips not
level.

Reseat microplate in carrier or strips in holder.
Make sure the carrier is clean.
Try a different microplate or strip holder. If the
problem is unresolved, the carrier may have to be
realigned. Contact BioTek TAC.

Aspirate tubes
position is too
wide for a
movement.

Change the horizontal, X- or Y-axis aspirate position
in the protocol.

Aspirate tubes
bent.

Contact BioTek TAC.

Loud,
annoying
noise during
operation.

Plate carrier is
rubbing
against glide
strip.

Thoroughly clean the microplate carrier and exterior
surface as recommended in the maintenance
procedure.

384-well
plates not
properly
washed.

Microplate
carrier not
moving
correctly in the
Y-axis.

Clean the plate carrier system. If problems persist,
contact TAC for assistance cleaning the carrier
transport arm.
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Problem Possible
Cause What To Do

Uneven
performance.

Plate carrier
leveling feet
damaged.

Replace plate carrier: contact BioTek TAC for
assistance. Note: "Q" model washers with Verify™
Technology must recalibrate the Verify test plate
after installing the new carrier.

Fluid Aspiration

Problem Possible Cause What To Do

Poor or
uneven
aspiration.

Insufficient or no
vacuum.

Firmly seat the waste bottle covers.  Ensure
tubing is connected properly.

Check all external tubing and in-line filter for
kinks or clogs. If you are using an in-line
vacuum filter, it may need to be replaced.

With the vacuum pump on, remove the
vacuum pump tubing from the back of the
instrument. Put your finger over the port; if
there is no vacuum, contact BioTek TAC.

Clogged aspiration
tubes on the
washer manifold.

Remove and clean the washer manifold

Make sure the microplate carrier is level and
the waste valve is not touching the bench.

Aspirate height
adjustment too
high or too low.

Change the aspiration height (Z-axis
position) in the protocol. Similarly, make sure
the Magnet Height offset is disabled or not too
high.

Vacuum pump
failure.

Contact BioTek TAC.
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Problem Possible Cause What To Do

Uneven
aspiration of
water buffer.
Some wells
left full.

No surfactant in
the buffer, such as
Tween® 20.

Add surfactant to the buffer. If this is not
possible, continue below.

Insufficient
vacuum.

BioTek offers a high-flow pump for assays
using only water for the wash fluid. Contact
BioTek for more information.

Protocol settings
not optimized.

Optimize protocols to improve evacuation

Aspiration tubes
not properly
positioned
horizontally in
wells.

If none of the tubes are bent, try adjusting
the horizontal aspirate position (X-/Y-axis) in
the protocol.

Microplate not level
in carrier, or strips
not level in holder.

Reseat microplate in carrier or strips in
holder.
Make sure the carrier is clean.
Try a different microplate or strip holder.
If the problem is unresolved, the carrier may
have to be realigned. Contact BioTek TAC.

Too much
residual left in
wells after
aspiration.

Clogged vacuum
filter.

If you are using an in-line vacuum filter (PN
49943), the filter may need to be cleaned or
replaced.

Waste bottle cover
not properly sealed
or fittings not
properly
connected.

Firmly seat the waste bottle stopper.  Make
sure tubing is connected properly.

Manifold out of
alignment or not
moving freely.

Check for obstructions. If none are found,
contact BioTek TAC.

Protocol requires
optimization.

Optimize protocols to improve evacuation.

Aspirate tubes are
bent.

Contact BioTek TAC.
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Fluid Delivery

Problem Possible Cause What To Do

Unable to
dispense
fluid.

Inlet tube not connected. Make sure all tubing is connected properly.
Check all external tubing for kinks or clogs.

Clogged fluid filter. Clean the fluid filter inside the supply bottle.

Clogged valve Create a protocol with several small primes,
e.g. 10 mL, to try to unclog valve.

Clogged dispense tubes
on the washer manifold.

Remove and clean the washer manifold

No wash or rinse fluid. Fill bottles with appropriate fluid. Ensure
bottles are clean and do not contain
particles or organic material.

Unable to
dispense
fluid.

System not primed.
Large air pockets in
tubing.

Run W-DAY_RINSE.

Insufficient suction,
clogged tubing, or faulty
valve.

PerformWasher Maintenance; If the
problem persists, contact BioTek TAC.

Plate
overfills
(floods).

Dispense height too
high. The aspirate tubes
are too far above the
wells to prevent
overflow.

Lower the dispense height (Z-axis position)
in the protocol.

Dispense flow rate too
low.

Define a higher dispense Flow Rate in the
protocol.

Cell wash flow rate 1 or
2 is used with 384-well
plates.

Specify a non-CW dispense Flow Rate when
using 384-well plates.

Aspiration tubes hit
bottom of trough during
Prime or Maintenance.

Manifold may not be properly seated or
mounted. Contact BioTek TAC.

In-line vacuum filter
plugged.

Replace or remove the in-line vacuum filter.
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Problem Possible Cause What To Do

Loose covers on waste
bottles.

Firmly tighten waste bottle covers.

Dispense rate too fast
for volume selected.

Specify slower dispense Flow Rate or lower
volume.

Faulty vacuum pump. Contact BioTek TAC.

Insufficient or no
vacuum.

Firmly seat the waste bottle covers.
Check all external tubing for kinks or clogs.
When the program begins, you should be
able to hear the vacuum pump turn on. If it
is not turning on, contact BioTek TAC.
If the vacuum pump turns on, remove the
vacuum tubing from the back of the
instrument and put your finger over the port.
If there is no vacuum, contact BioTek TAC.

Uneven
dispensing
of fluid;
wells not
filled.

Clogged dispense tubes
on the washer manifold.

Remove and clean the washer manifold

Manifold or tubing not
adequately primed.

Run W-DAY_RINSE once or twice.

Dispense flow rate too
low. Flow rate 1 or 2 CW
is used with 384-well
plates.

Define a higher dispense Flow Rate.

Microplate aspiration
height adjustment too
high or too low.

Change the aspirate height (Z-axis position)
in the protocol.

BioTek Instruments, Inc.
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Fluid Leakage

Problem Possible
Cause What To Do

Fluid
leaking
from
manifold.

Defective
seals.

Contact BioTek TAC

Aspiration
tubes
only:
vacuum
too low.

Check waste connector tubes; make sure they are
properly connected.
If you are using an in-line vacuum filter, check the filter
for clogging, and replace if necessary.
Check seal of waste bottle covers.
Check for air leaks in the waste tubing and bottles.
Use a slower Aspiration Travel Rate.
Direct Drainwaste system users: if the aspirate
manifold is dripping at the end of a run, add a Prime step
to the protocol to precede the wash. This will turn on the
vacuum pump and keep it running during the protocol to
prevent the manifold from dripping on the plate.

Uneven
(not level)
surface.

Make sure the washer sits on a perfectly level surface.

Fluid
leaking
from
underneath
the
instrument.

Defective
tubing
connector
or inlet
tubing.

Contact BioTek TAC.

Leaking
valve.

Contact BioTek TAC.

Fluid
leaking
from
external
tubing
connector.

Defective
connector.

Replace connector.

Worn
tubing.

Replace tubing or cut back tubing one inch (to remove
worn section).

Worn seal
(inlet or
vacuum
fitting).

Replace filter or seal.

405™ TS Microplate Washer
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Washer Manifold Movement

Problem Possible
Cause What To Do

Manifold
position
error.

Manifold
movement is
blocked.

Check orientation of microplate; A1 should be in the left
rear corner of the plate carrier as you face the
instrument.
Check for and remove any obstructions.
Ensure the manifold is installed properly.

Incorrect
manifold
selected.

Make sure the washer manifold setting matches the
installed manifold (96-, 192--tube).
LHC: Tools>Instrument Utilities>Washer>Manifold
Selection.
Touch screen: Instrument>Options>Manifold Selection

BioTek Instruments, Inc.
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Vacuum Pump Problems

Problem Possible Cause What To Do

Vacuum
pump does
not start, or
shakes when
turned on.

Vacuum pump is
not turned on.

Flip the switch on the side of the vacuum pump
to turn it on.

Vacuum pump
accessory cable
not installed
correctly.

Plug the vacuum pump accessory cable into
the back of the instrument, Accessory Outlet.

Too much residual
vacuum force for
pump.

Release the vacuum by loosening the waste
bottle stopper. Reconnect and start again.

Blown fuse in
accessory outlet.

Plug the vacuum pump accessory cable into
the back of the instrument, Accessory Outlet,
not into a wall outlet.

Increase vacuum dissipation delay.
LHC: Tools>Instrument Utilities>Vacuum
Dissipation Delay.

Touch screen: Instrument>Options>Advanced
Settings

Replace fuse (PN 46055), Replace the Vacuum
Pump Fuse

Repeated
blown fuses.

Vacuum Dissipate
Delay is set too
low for the volume
of the waste
bottle.

See above. If not enough time is allowed for
the vacuum to dissipate, the pump will try to
start while it is under a vacuum. The pump
draws excessive current and blows the fuse.

Pump has been
flooded.

Remove the head from the pump and inspect it
for corrosion, crystalline buildup or liquid.
Contact BioTek TAC for information on pump
rebuilding kits.

405™ TS Microplate Washer



Specifications and Part
Numbers

For your convenience this section contains commonly sought
reference information. Consult the operator's manual on CD
for more complete information.

Physical Specifications 104
Performance Specifications 105
Package Contents 107
Optional Accessories 110



104 | 405 TS Getting Started Guide

Physical Specifications

Labware

Microplates 96-well, 384-well that comply with SBS microplate standards
1-2004, 2-2004, 3-2004, and 4-2004.

Microstrips 1 x 8, 1 x 12

Microwells Flat, round, "V” bottom

Hardware & Environmental

User Interface 5.7" touch screen

Power Supply The instrument uses two internal power supplies: 24-volt 60
watt and 48-volt 60 watt. These supplies are compatible with
100-240 V~; 50-60 Hz.

Accessory
Outlet

≤ 5.0 A, used for vacuum pump

Dimensions
(W x D x H)

14 x 17 x 10 inches (36 cm x 43 cm x 25 cm)

Weight (≤) 32 lb (14.5 kg)/36 lb with Buffer Switching (16.3 kg)

Operating
Conditions

10° - 40°C (50° - 104°F)

Relative
Humidity

The instrument should be operated in a non-condensing humid
environment having a maximum relative humidity of 80% at
temperatures up to 31°C decreasing linearly to 50% relative
humidity at 40°C.

Manifold Type

96-tube Single or Dual manifold with 96 sets of aspirate and dispense
tubes arranged in an 8x12 array. Single manifolds can only
process 96-well microplates; dual manifolds can process 96-
and 384-well plates.

192-tube Dual manifold with 192 sets of aspirate and dispense tubes
arranged in a 16 x 12 array can only process 384-well plates.

405™ TS Microplate Washer
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Waste bottle volume 4, 10, or 20 liters, depending on the accessory
package, (2 bottles, one with sensor)

Supply bottle volume 2 4L or 10L bottles (4 bottles w/ Buffer Switching)

Performance Specifications

Average Residual Volume (Evacuation Efficiency)

96-Tube
Manifold (Single
and Dual)

Average residual volume in the microwells is ≤ 2 µL per well
after a 3-cycle wash, when 300 µL of deionized water with
0.1% Tween 20®, or buffer equivalent, is dispensed per well
into a Costar® 96-well flat-bottom plate. The aspirate height
adjustment is optimized for the plate prior to testing.

192-Tube
Manifold

Average residual volume in the microwells is ≤2 µL per well
after a 3-cycle wash, when 100 µL of deionized water with
0.1% Tween 20, or buffer equivalent, is dispensed per well into
a Costar 384-well flat-bottom plate. The aspirate height
adjustment is optimized for the plate prior to testing.

Vacuum Filtration Evacuation Efficiency

96-Well Filter
Plates

Average increased weight of the plate is ≤ 1.2 grams after
dispensing 300 µL of deionized water per well into a
Millipore® MSHVN4450 96-well 0.45µm plates (PN 98258)
and vacuum aspirated for 30 seconds and blotted on a
paper towel.

384-Well Filter
Plates

Average increased weight of the plate is ≤ 4.0 grams after
dispensing 80 µL of deionized water per well into a
Millipore® MZFCN0W10 384-well 1.2µm plates (PN 98287)
and vacuum aspirated for 10 seconds and blotted on a
paper towel.

Dispense Precision

96-Tube
Manifold

≤ 3.0% CV when dispensing 300 µL per well of deionized water
with 0.1% Tween 20, with FD&C #1 blue dye at rate 6 into a
Costar 96-well flat-bottomed plate. The absorbance of the
solution is read at 630 nm and 450 nm reference.

BioTek Instruments, Inc.
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Dispense Precision

192-Tube
Manifold

≤ 4.0% CV when dispensing 80 µL per well of deionized water
with 0.1% Tween 20, with FD&C #1 blue dye at rate 7 into a
Costar 384-well flat-bottomed plate. The absorbance of the
solution is read at 630 nm and 450 nm reference.

Verify™ Clog Detection Technology

Timing A Verify test shall be completed in less than 5 minutes from
initiation until test results are displayed.

Performance The Verify level sensor measurement shall have a repeatability
standard deviation of σmeasurement <0.14 mm (9.0 µL for 8X8
square well plate), where the σmeasurement applies to a relative
volume measurement, i.e. the delta between two volumes.

405™ TS Microplate Washer
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Package Contents

l Part numbers and package contents are subject to change and vary
according to instrument model. Please contact BioTek Customer Care if
you have any questions.

Description PN

Power cord (part numbers vary by country of use) Varies

USB cable (USB Virtual COM Port Driver Software &
instructions)

75108

Microplate carrier Varies

Mist shield 1172017

Accessory kit 1170012

Stylus: for cleaning washer manifold aspirate tubes 7102108

Stylus: for cleaning washer manifold tubes 2872304

Stylus: for cleaning 192-tube dispense manifold 7102139

Shipping bracket - model dependent 7102138
1242018 or
1242021
1242032 and
1242019

Hex wrench: 9/64” 48434

Spare fuses (5) 46055

Verify Test Plate for "Q" models only 01588

Manifold Stop Screw Kit (Required for Vacuum Filtration,
384-Well PCR processing and magnetic bead assays.)

1170011

405™ TS Getting Started Guide (and operator's manual on
USB - PN 1171039)

1171009

l Some components are model specific, they ship only with certain
instrument models.

BioTek Instruments, Inc.
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Waste and Dispense System Accessories

Part
Number Description

Standard Vacuum Pump Systems:

1170530 Complete Dispense/Waste System 115V/230V, 4L Bottles, including:

7100746 Waste: 4L bottles (2, one with sensor)

1170529 Dispense: 4L bottles with filters (2)

7100746 Complete Waste System 115V/230V, 4L Bottles, including:

7100543 Waste: 4L bottles (2, one with sensor)

7103024 Vacuum pump 115V/230V

1170535 Complete Dispense/Waste System 115V/230V, 10L Bottles, including:

1170534 Waste: 10L bottle (1), 4L bottle with sensor (1)

1170528 Dispense: 10L bottles (2)

1170534 Complete Waste System 115V/230V, 10L Bottles, including:

7100582 Waste: 10L bottle (1), 4L bottle with sensor

7103024 Vacuum pump 115V/230V

High Flow Vacuum Pump Systems:

1170532 Complete Dispense/High Flow Waste System 115V/230V, 4L Bottles,
including:

7100753 Waste: 4L bottles (2, one with sensor)

1170529 Dispense: 4L bottles with filters (2)

7100753 Complete High Flow Waste System 115V/230V, 4L Bottles, including:

7100543 Waste: 4L bottles (2, one with sensor)

7100754 High-flow vacuum pump 115V/230V

1170533 Complete Dispense/High Flow Waste System 115V/230V, 10L Bottles,
including:

1170531 Waste: 10L bottle (1), 4L bottle with sensor

405™ TS Microplate Washer
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Part
Number Description

1170528 Dispense: 10L bottles (2)

1170531 Complete High Flow Waste System 115V/230V, 10L Bottles, including:

7100754 High-flow vacuum pump 115V/230V

7100582 Waste: 10L bottle (1), 4L bottle with sensor (1)

Direct Drain Vacuum Pump Systems:

1170536 Complete Dispense/Direct Drain Waste System 115V/230V, 4L Bottles,
including:

1170529 Dispense: 4L bottles with filters (2)

Direct drain vacuum pump & tubing

1170537 Complete Dispense/Direct Drain Waste System 115V/230V, 10L
Bottles, including:

1170528 Dispense: 10L bottles with filters (2)

Direct drain vacuum pump & tubing

Notes:

1) Models with Buffer Switching receive a dispense system. Only a waste system
must be ordered separately.

2) High-flow waste systemmay be necessary for 384-well washing with buffers not
containing surfactant.

3) Direct Drain Waste System: use restricted to 96-tube single manifold models
(i.e. 405 TS).

BioTek Instruments, Inc.
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Optional Accessories

General Instrument Accessories

Description PN

BioTek liquid testing solutions for
instrument qualification tests

Wetting
Agent

7773002

Blue Test
Dye

7773001

Liquid Handling Control™ Software LHC2

BioStack™ Microplate Stacker and integration kit Biostack

Installation-Operational-Performance Qualification
(IQ-OQ-PQ) package

1170522 

Washer Accessories

Magnetic Bead Assay Accessories

Accessory PN

Magnets:

384-well Flat Magnet 7103017

384-well Ring Magnet 7102215

96-well Flat Magnet 7103016

96-well Ring Magnet 7102216

Vacuum Filtration Kit

Description PN

-- 96-well Only 1170008

-- 96- and 384-well 1170009

Verify™ Technology Accessories

Description PN

Verify Test Plate Replacement Kit 1240001

405™ TS Microplate Washer
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Miscellaneous Accessories

Description PN

96-tube Manifold Kit - Replacement kit for 405 Select to
support 384-well non-surfactant buffer washing (Tube-in-
Tube).

1172046S

96-Tube 7-Degree Dual Manifold Upgrade Kit - Additional
manifold for 405 HT for 96-well washing. (Tube-in-Tube)

1170010

4L Dispense Bottle w/filter 1173031

Cap for 4L Dispense Bottle w/filter 1173003

10L Dispense Bottle w/filter 1173000

Cap for 10L Dispense Bottle w/filter 1173002

Dispense Tubing Set - 1 Buffer 7100538

Dispense Tubing Set - 4 Buffers (For Buffer Switching
models.)

7100537

4L Waste Bottle 7100534

Cap for Waste Bottle, 4L (Also fits 10L and 20L bottles.) 7100531

Waste Bottle with Level Sensing, 4L 7100542

Cap for Waste Bottle with Level Sensing, 4L 7100544

10L Waste Bottle and Tubing 7100557

20L Waste Bottle and Tubing 7100556

Waste Tubing Set 7100533

Vacuum Line Filter for Waste Tubing 48294

Vacuum Gauge/Regulator (For use with house vacuum.) 4030551

Silencing Muffler for Vacuum Pump (For use with P/N 7103024
pump.)

01113

Fluid filter for dispense bottles (does not include stainless
steel adaptor 1172031)

01310

BioTek Instruments, Inc.
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BSA 80, 82
Buffer Switching
installation 17

C

Cell Wash 51-52
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Change
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Cleaning 80
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COM Port 22, 39
CW+ Control 51
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Delay after Dispense 54
Delay Aspiration 54
Direct Drain 100
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High Flow vacuum pump
Caution 89

Horizontal aspirate position 95
Humidity limits 104

I

Instrument Settings
Defining 22

Instrument Utilities
AutoPrime 70

IQ-OQ-PQ 110

L

Labware 104
Liquid test solutions 110
Low Flow 51
Low vacuum 96

M

Magnet Height Offset 61, 69
Magnetic bead assays 56
Maintenance 77
Removing proteins 82

Manifold Selection 69
Manifold Type 104
Microplate carrier
Vacuum filtration 67

Microplates
supported types 104

P

Package contents 107
Parts listing 107, 110
Performance Specifications 105
Performance verification
After installation 25

Physical Specifications 104
Plate carrier
Vacuum filtration 67

Plate Type
supported 104

Port link 39
Power Supply 104
Prevent fluid loss during wash 54
Protein
Preventing clogging 82

Protocols
Customize 39

Q

Qualification
Instrument 25

R

Rates
Washer flow rates 43

Re-stack plates 50
Residual too high 97
Robotics integrators 48

S

Sensors 69
serial port 21, 48, 95
Size and weight 104
Soak 81
Sonicator 80
Specifications 104-105

T

Terg-A-Zyme 80
Troubleshooting 94
Washer problems 95

Tubes
Installation of 14

U

Ultrasonic Advantage 80
USB 94
Use BioStack 49
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V

Vacuum
Low 96

Vacuum Dissipate 22
Vacuum on based on volume 54
Valve module
installation 17

W

Wash
Gentle, cell wash 51
Magnetic beads 56
Polystyrene beads 64

Washer
Fixing problems 95
Protocol parameters listing 43
Washer Prime step 38

Washer Settings 69
Waste system
Installation 15
sensor 69
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405 TS/LS Chemical Compatibility Chart

Table 1: Material/Where Used List

# Material Where Used
1 304 Stainless Steel Inlet screen, feeder tube to manifold, vacuum 

switch
2 316 Stainless Steel Dispense and aspirate tubes, feeder tube to 

manifold, spring in bottle fittings
3 Acetal Vacuum filtration plug
4 Aluminum (anodized) Microplate carrier, vacuum filtration carrier grill 

and retainer
5 CPVC (Chlorinated Polyvinyl 

chloride) Manifold, vacuum filtration carrier
6 Nylon Inlet fitting, vacuum switch adjustment screw, 

carrier leveling feet
7 PTFE (polytetrafluoroethylene)  

Teflon
Optional check valves (PN: 68098) for fluid 
pump, direct drain pump, fluid path

8 EPDM (Ethylene Propylene) Inlet valve, vacuum filtration 3-way valves, 
vacuum switch diaphragm

9 Neoprene Manifold channel-end seals
10 PPO (polyphenylene Oxide) 

Noryl®
Vacuum switch internal disc

11 Polycarbonate Vacuum switch body, Vacuum filtration 
intermediate waste bottle, direct drain 
intermediate waste bottle

12 Polyethylene Buffer bottle
13 Polypropylene Outlet fitting, fittings in bottles, inline fittings, 

float ball, bottle caps, vacuum filtration module 
bulkhead fittings

14 Polystyrene Flow sensor, mist shield, assay plates
15 PVC (Polyvinyl chloride) Inlet valve, waste sensor, flow sensor ball 

retainer, waste tubing, vacuum filtration plug
16 PPS (polyphenylenesulfide) 

Ryton® 
Fluid pump, vacuum filtration plug, inlet valve 
(serial # less than 207137)

17 Thermoplastic elastomer 
Santoprene® Fluid pump check valves

18 Silicone Inlet tubing, outlet tubing, o-rings, vacuum 
filtration carrier gasket, vacuum filtration 
module tubing

19 Ultem (polyetherimide) Outlet valve, CW inlet valve, vacuum filtration 
module valves

20 Viton Outlet valve, CW inlet valve



Appendix C: Chemical Compatibility

BioTek Instruments, Inc.

Table 2: Chemical Compatibility Ratings
 

Key 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
A - Excellent 
B - Good
C - Fair

D - Severe effect/Poor
ND - No data

Chemical 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
Acetic Acid, 5% D A D B A D A ND B A A A A D D A C C A B
Acetic Anhydride B A D A D A A A B D D C B D D A A A ND D
Acetonitrile ND A ND B D A A C ND ND D A A D D A ND D D D

Ammonia 10% A A D A A A A ND A A D N A B B A A D D D
Benzyl Alcohol B B A B A B A B C D ND A A D D A A A ND A
Chloroform A A A B D A A D D D D D C D D A D D D A
Detergents 1% A A A B A A A A A A A A A A A A B A A A
Dimethylformamide A B D A D A A B D D D C A D D A D A ND C
DMSO (Dimethylsulfoxide) ND A ND A D A A B ND ND D A A D D A D C D D
Ethyl Alcohol 70% A A A A B A A A A A B B A A B A B B A B
Ethylene Oxide B B D D C D A C D A C A D C C D ND A ND C
Formaldehyde 37% A A A B A A A A B A A D A ND A A ND C A A
Hexane A A A A B B A D B B D A B D B A ND D A A
Hydrocholoric Acid 20% D D C D A D A A C B B A B C A D A D A A
Hydrofluoric Acid 20% D D D D C C A C B C D A A ND B A A D ND A
Hydrogen Peroxide 10% B B D A A A A A B A A A A A A C ND A A A
Isopropyl Alcohol 70% B A A A B D A A B A A B A A B A ND A A A
Methyl Alcohol 70% A A A A A B A A A A B A A ND A A B A A A
Methylene Chloride B B B C D C A ND D D D D B D D A D D D B
Phosphoric Acid >40% D D D C A B A A B A A A A B B A A C A A
Propylene Glycol B B B B C A A ND C ND B A A A C A ND A ND A
Sodium Chlorate A B A C A D A ND A A A N A ND A A A C ND A
Sodium Hydroxide 20% B B A D A A A B B A A A A A A A ND A A A
Sodium Hypochlorite <20% C C D D A D A B C A C A A A A C ND B B A
Sodium Hypochlorite 0.5% B B ND D A ND A B C ND C A A A A C ND B A A
Sulfuric Acid <10% D B D B A A A A B A A A A A A A A C A A
Trichloroethylene B B D D D C A ND D D ND D C D D A D D D A
Virkon 10% ND A ND D A A ND A ND ND A A A A A A ND A ND A

This ratings information was obtained from several reputable sources and our own experience at BioTek, but your 
experience may differ due to variations in concentration, temperature, and other factors. Consult the reagent/solvent 
manufacturer before use to verify its compatibility with instrument components.  
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405 TS Customer Training Guide

Instrument

Hardware

l Review flow routing and tubing
connection for Supply and Waste (page
14)

l Review Mist Shield installation and
cleaning

l Show location of washer aspirate/
dispense tubes, describe method of
operation and manifold design

l Show location and function:

l priming trough

l carrier

l vacuum pump outlet

l fuse and describe how to replace it

l Review ports:

l USB

l Vacuum Filtration

l waste monitor

l Demonstrate Verify Technology (page
34)

l Review Chemical Compatibility

Onboard Software

l Show startup and priming procedure

l Show Quick options:

l Prime

l Wash

l Clean: Sonicate Manifold

l Select and run a protocol (page 39)

l Create a protocol (page 32):

l Wash

l Aspirate

l Dispense

l Soak/Shake

l BioStack (page 49)

l Show how to use Align utility

l Explain/recommend AutoPrime (page 70)

l Review end of day procedures

BioStack Interface

As applicable

l Alignment kit, 90 or 0, or -90 degree wrist, 50-
plate stacks (if applicable)

l Enable BioStack

l Align gripper/claw

l Potential issues with non-SBS compliant
microplates; microplate stack adjustment

l Demonstrate operation,
instrument control

l Instrument control - must
create a protocol (page
49)

l LHC Control

l Settings/Restack



LHC Software

l Show how to establish communication

l Review the options in the Target Instrument Settings

l Create and run a simple protocol

l Review the Instrument Utilities dialog options

Preventive Maintenance

l Recommended maintenance schedule
(page 77)

l Cleaning in-bottle filter (page 83)

l Review programs:

l Day Rinse

l Overnight Loop

l Rinse and Soak

l Long Shutdown

l Decontamination

l Manifold cleaning procedures

l Stylus manifold

l Carrier cleaning procedures

Special Applications

As applicable

l Cell wash assays: define a protocol (page 51)

l Magnetic bead assays: review accessories; Magnet Adapter Height setting (page 56)

l Vacuum filtration assays: review accessories; enable module; Plate Carrier setting;
define a protocol (page 64)

Exercises

As applicable

l Create a protocol for:

l ELISA

l BioStack

l Run a Quick Wash:

l Buffer: D

l Cycles: 2

l Volume: 250 µL



Reference Material

l 405 TS Operator's Manual (on CD/USB stick)

l Touch screen Help

l LHC Help

l BioStack Operator's Manual
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